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What Is Team Server

What Is Team Server

Team Server is a web-based tool to access, search, edit and manage enterprise
metadata. It provides access to metadata from ER/Studio Repository, and it allows you
to manage additional metadata, such as glossaries and terms or data sources.

Team Server allows you to keep track of your metadata and discuss its evolution with
other users. It also lets you create reports easily from your data and searches, and export
them to different file formats.

Team Server also enables you to:

o Search for all kinds of data, such as data definitions and ER objects in any model
of your ER/Studio Repository database, including ER/Studio Data Architect
and ER/Studio Business Architect diagrams. Team Server has simple and
advanced searching capabilities to find ER objects and other resources, as well as
their reuse and impact analysis.

o Browse all the contents of your ER/Studio Repository database, such as models
and dictionaries, in a structured way.

ER/Studio Team Server Users
-
s DD
i 9 - D
- Q » i

D3 2 .
“ F—-"i‘ Dh}; - L’? i

ER/Studio Users

L)

Using a web browser, you can access Team Server internally, via your corporate intranet,
or externally, via the internet. This way, you can access all the information you need from
anywhere.
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User Guide

User Guide

This volume of help describes how to use Team Server as a authenticated user.

Topics

o Connecting to Team Server

o Searching

o Working with Resources:

»  Glossaries

= Terms
» People

= ER Objects

» Data Sources

* Login Credentials
o Using Reports

o User Interface

See Also

o Overview of the User Interface

o Administrator Guide
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Connecting to Team Server

Connecting to Team Server
Go Up to User Guide
To connect to a running instance of Team Server:

1. Open a web browser. See Supported Web Browsers.

2. Browse to the Team Server URL, as provided by your super user. The web
browser shows the Team Server login page.

» Tip: If you are the super user, see Starting Team Server for more
information.

3. Enter your Username and Password, as provided by your super user. The default
user being Admin > Admin.

4. Optionally, click "Remember me" to store your user credentials in the web
browser, so that you do not need to enter them again.

5. Click Login.

i

Welcome to Embarcadero Team Server

Username
|

Password

Embarcadero Team Secver Version 4.0
embarcadero  :suiomonnm

You should now be logged in to Team Server. If you are unsure of what to do next, the
Start Here Page will guide you.

For further information see the User Guide.

See Also

o Troubleshooting, Connecting to Team Server

o Starting Team Server

o Login Page
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Configuring Your User Profile

Configuring Your User Profile

When you are a social user, other social users can search for you and see details about
you in your Description page.

To configure the information in your description page:

1. Open your person page. For example, click your username or user image in your
Home page.

2. Click Edit on the upper-right corner of your person page.

3. In the Configure Profile page:

1. In Photo, click Browse and select an image file that you want to represent
you in Team Server.

2. Fill Title with your job title. This field is mandatory.

3. You can enter in First Name your display name, which Team Server
displays in places such as the Stream subpage.

4. Write a detailed description of your job responsibilities in Job
Description.

5. Fill your Phone number so other users can contact you by phone.
6. Fill Email with your email address.

7. Under Stream Moderation, you can check or uncheck the following
options:

* "Allow others to post to your stream"”. Check this option so that
other users can post comments associated with your user.

* "Allow others to comment on activity in your stream". Check this
option so that other users can reply to items in your activity
stream.

8. Click Save Changes to save your changes.

See Also

o Configure Profile page

o Interacting with People
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Using Social Features

Using Social Features

Team Server provides two different user profiles: social and non-social. The social
version of Team Server is a useful system for users to share their experiences with other
users and keep track of the activity related to the resources of their interest.

The content of this page focuses on the features that Team Server offers to social users.
These features are not available for non-social users. See Overview of User Experiences
to understand the main differences between these two experiences.

Interface for Social Users

You can access features and settings with the User Menu of the interface and search for
any resource in the Reporting Repository using the Global Search Box option. The
interface also includes a Navigation Menu with the main Team Server features. See
Overview of the User Interface for more information about the interface.

Global Search Box

User Menu

Navigation Menu

Navigation
Sidebar Page Body

Interaction with Resources

You can interact with any resource (glossaries, terms, ER objects, and data sources).
Interaction includes having discussions (making comments) with other users about
resources, tracking the changes and discussions related to resources and following
people activity surrounding resources. For that purpose, you can use the following
features:

o Stream
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Using Social Features

The Stream page shows the activity related to the current resource. This activity involves
changes surrounding resources, such as start following a resource, as well as comments
related to these changes. The activity stream is shown on the Home page and on the
current resource pages. On the Home page, you can filter the content in the activity
stream. See Stream page for more information.

) Start Here Followers
write a comment.
Stream n
Description
1 [10 [=] Following
< previous page 1 2 - vt e > 10 |%] items per page
oy Community u
@ Documentation ! # hllomang glossary sy
Peapie
t creat lossary Hoe P : )
? created glossary B Faocts
Q podted 1o parton
I hawe imporied a lot of terms this week. Feel free to check.

! created glossary Test

o Discussions

You can see and edit comments related to a resource using the Discussions Tab of the
navigation sidebar. In the current resource page, you can select the Discussions option
to see the conversation about this resource or start a new one. A discussion can be
expanded to show other users' comments. Each entry displays the image, the username
and the actual text of the author and the date when the author wrote the reply. See
Discussing Resources for more information.

@Note: Team Server shows comments related to an ER Object made in ER/Studio
Data Architect. To view the comments click the icon next to the ER Object in the Model
Explorer.

eémbarcadero

Home Glossaries Terms People ERObjects ERTools DataSources

(), Advanced Search

Model Explorer

4 Comment(s)

v Favorite Reports v i ESEBTCONNECT
v & Projects
¢ Favorite Searches , G _
e
.{; Model Explorer » B Enterprise Dictiorkfes

» B} Workspaces
My Reports

Shared Reports
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Using Social Features

o Following a Resource

You can track other users' activity in relation to resources. This activity appears on the
Home page when people that you are following edit resources, post comments to
resources, and so on. The Following a Resource feature provides a practical tool for the
personalization of the system according to the user's interests. See Following a Resource
for more information.

Skeaes admin
Description User
Followers
Following
< prenous page 12 ext poge > 10 |V ftems per page
7 Alert Group 1
L :
@, Growp
ANF

Apache
Business Terms

Ceenplete removal of an amount due, (Uually referrng to a tax ASATEMENT a penalry

Apache

“Complete removal of 30 amount due

Available space

Metric

© [ m

See Also

o Overview of User Experiences

o Overview of User Roles

o Overview of the User Interface
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Using Reports

Using Reports

Team Server provides several standard reports. You can access the standard reports
from the Solution Browser page. See Shared Reports for a list of available standard
reports.

When you execute a standard report, you are prompted to supply custom parameters
that filter and format the results of the report. Those parameters depend on each other;
that is, the value that you choose for one parameter determines the available values for
other parameters. For example, if you select a certain project, you can only select
diagrams that exist within the selected project. See Generating a Shared Report to learn
how to use standard reports.

Team Server lets you generate reports not only in HTML, but in PDF and XLS (Microsoft
Excel spreadsheet) as well. You can save reports to run later and share them with other
users. You can also print and email the reports.

Using the Web Adhoc Query and Reporting wizard, you can create your own custom
reports, and save them into the Solution Browser page, where you can organize them
into folders. You can run your custom reports whenever you want, and you can share
them with other users.

The content of the custom reports is limited to the structured business views created
using metadata. The metadata module generates SQL code based on business views
that you specified during development. You can modify the business views using the
Pentaho Metadata software.

Topics

o Generating a Shared Report

o Adding a Shared Report to Favorite Reports

o Sending Reports By Email

See Also
o My Reports

o Solution Browser

o Web Adhoc Query and Reporting Wizard
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Adding a Shared Report to Favorite Reports

Adding a Shared Report to Favorite
Reports

You can save the parameters of a shared report in your list of Favorite Reports, so you
can later access the report easily.

To make a shared report favorite:

1. Open the Solution Browser page:

* Asasocialuser: ER Tools > Shared Reports.

* As anon-social user: Shared Reports.

2. Under Shared Reports, click either Business Reports or Technical Reports.

3. Click the name of the report you want to make favorite. For additional
information about the standard reports, see Shared Reports.

Note: Users can see all shared reports, regardless of whether or not they have
permission to access the ER objects that the report accesses. However, when users that
try to run a report that access ER objects which users do not have permission to access,
users get an error message instead of the results of the report.

4. On the Shared Report Configuration Page page that opens:
1. Choose the parameters for your report.

2. Inthe View as combo box, choose the desired type of output for the
report results: html, pdf or xls.

3. Click Add to Favorites.

2. Inthe Add to favorites dialog that opens:

1. Enter a Name to save the report with in the Favorite Reports list.

2. Write a Description for the report.

3. Check the Shared checkbox if you want to make the shared report public.
4. Click Submit to make the shared report favorite.

After you save your new report as favorite, you can find it in the Favorite Reports page. If
you are a non-social user, you can find your favorite reports in the Home page as well.

See Also

o Generating a Shared Report

o Favorite Reports
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Generating a Shared Report

Generating a Shared Report

To generate a shared report:

1. Open the Solution Browser page: ER Tools > Shared Reports.

1. Under Shared Reports, click either Business Reports or Technical Reports.

2. Click the name of the report you want to run. For additional information about
the standard reports, see Shared Reports.

Note: Users can see all shared reports, regardless of whether or not they have
permission to access the ER objects that the report accesses. However, when users that
try to run a report that access ER objects which users do not have permission to access,
users get an error message instead of the results of the report.

3. On the Shared Report Configuration Page page that opens:
1. Choose the parameters for your report.

2. In the View as combo box, choose the desired type of output for the
report results: html, pdf or xls.

3. Click Run to generate the target report.

See Also

o Adding a Shared Report to Favorite Reports

o Solution Browser

o Shared Report Configuration Page page
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Sending Reports By Email

Sending Reports By Email

If emailing reports is enabled, follow these steps to send a report by email:

1. Open the Solution Browser page: ER Tools > Shared Reports.

2. Under Shared Reports, click either Business Reports or Technical Reports.

3. Click the name of the report you want to make favorite. For additional
information about the standard reports, see Shared Reports.

Note: Users can see all shared reports, regardless of whether or not they have
permission to access the ER objects that the report accesses. However, when users that
try to run a report that access ER objects which users do not have permission to access,
users get an error message instead of the results of the report.

4. On the Shared Report Configuration Page page that opens:
1. Choose the parameters for your report.

2. In the View as combo box, choose the desired type of output for the
report results: html, pdf or xls.

3. Click Send by Email.
5. In the Email Report dialog that opens:
1. Specify in To an email address of the recipient.

2. Click Submit to send the message.

See Also

o Generating a Shared Report

o Adding a Shared Report to Favorite Reports

o Enabling Emailing Search Results and Reports

o Favorite Reports
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Overview of the User Interface

Overview of the User Interface

The Team Server user interface consists of the following elements:

Global Search Box E

User Menu  myseing: ~itogou

Navigation Menu

Navigation
Sidebar Page Body

o Global Search Box. Lets you search for any resource in the Reporting
Repository.

o User Menu. Provides access to user features and settings.

o Navigation Menu. Provides access to the main Team Server features.

o Navigation Sidebar. Lets you switch between the different pages of a major
section. It changes depending on the current section.

o Page Body. Shows the content of the current page.

Page Index
This is a list of pages and types of pages that you can find in Team Server:

o Login Page

o Resource Pages

o Report Pages
o Search Pages

In the Navigation Menu we have eight tabs available:
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Overview of the User Interface

o Home: Your personal home page, including documentation links, getting started
content videos and your Stream page, that shows your activity and the activity of
the resources that you are following.

o Glossaries: The Glossaries page is a search page that allows you to search for
glossaries, edit, or create new ones.

o Terms: The Terms page is a search page that allows you to search for terms, edit,
or create new ones.

o People: The People page is a search page that allows you to search, edit, or
create new users.

o ER Objects: The ER Objects page is a search page that allows you to search for
ER objects.

o ERTools: Allows you to navigate to the business and technical reports, and
create custom reports. From here you can also access your favorite and shared
searches and reports.

o Data Sources: The Data Sources page is a search page that allows you to create
or search for data sources, login credentials and data sources groups.

See Also

o User Guide
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Global Search Box

Global Search Box

1

The Global Search Box is a search box which is always available in the upper-right
corner of the Team Server user interface.

To perform a search, enter your search terms into the search box and press d

What happens then depends on your type of user account:

o Ifyou are a social user, Team Server opens a global search page, a search page
that includes every kind of resources: ER objects, people, glossaries, and so on.

o Ifyou are a non-social user, please see: Global Search Box

See Also

o Search Pages
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Online Help for Team Server 2016

Online Help for Team Server 2016

Getting Started

o % What's New

o Release Notes

o Installation Notes | Database Server Requirements

o Install and Configure Team Server and Repository

o Upgrading Team Server and Repository

o Tutorials

Administrator Guide

o Starting Team Server

o Data Synchronization

o Security
o Scheduling

o Maintenance

o Configuration
* Admin Page

» Manage Search Results

» Changing the Interface of Team Server

* Manage Glossary Tool Tips

* Optimizing System Performance

o Architecture

o Tools

Reference

o Evaluation Resources

o Troubleshooting

o Glossary
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Online Help for Team Server 2016

User Guide

o Connecting to Team Server

o Working with Resources:

=  Glossaries

= Terms
» People

*» ER Objects

» Data Sources

= | ogin Credentials

o Using Reports

o User Interface

Developer Guide

o Obtaining Authorization to Use the API
o Browsing Resources
o Managing Resources

o Enabling Secure APl Requests

o APl Reference

ER/Studio Team Server Core

Enterprise model and metadata collaboration
for context, consistency, and compliance
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Resource Pages

Resource Pages

While non-social users can only interact with ER objects, social users enjoy access to
other kind of resources: glossaries, terms, people, and data sources.

The pages of each one of those types of resources have a couple of things in common:

Company Glossary
—— | e ' Resource
Terms Header

Followers

Navigation Subpage Body
Sidebar

o Navigation Sidebar. Allows you to switch between the different subpages of
your resource. Different types of resource provide different subpages.

o Resource Header. The resource header displays an icon representing the
resource, the name of the resource, and some additional information and

actions, depending on the type of the resource.

o Subpage Body. This area displays the content of the resource subpage selected
in the navigation sidebar.

When you open a resource page, the Description subpage, common to all resource
pages, is opened by default.

See Also
o Searching
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Stream

Stream

The Stream page displays the activity associated with the current resource, such as
changes or user comments. This page is only available for social users.

This page contains of the following:

o A header to write comments to the current resource and search or filter the
activity.

o The activity stream, which contains all kinds of activity entries associated with the
current resource.

o A sidebar on the right-hand side, which lists different data depending on the
type of the current resource.

1) Start Here ) Followers
Write a comment...
Q lauram
Stream 1=
Filter | Search
Description
< previous page 1 2 . next page > Il(} . items per page Followmg
o2 Community
"
admin is following glossary Home -
o Documentation - 99 " Glossary
Jul 27, 2015 2:19:56 PI Share Delete A lauram
Pecple
testuser created glossary Home g testuser
A5, Pecple
5 ul 27, 2015 2:12:24 PI Share Delete
q lauram posted to person lauram

I have imported a lot of terms this week. Feel free to check.

ul 27, 2015 1:33:09 P Share Delete

admin created glossary Test
Jul 17, 2015 2:00:37 PI Share Delete

Stream Header

The header of the Stream page provides the following fields:
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Stream

[tem Description

Write a comment  [You can write a comment on this field and press d tosendit.

Users following the current resource can see the comment on their Home
page, and reply you.

<n> of <n> filters |Click this field to expand the list of available filters. Then, you can check or

(only your user uncheck options to filter in or out content in the activity stream, and click
and Home pages) |Done to apply the changes.

You can click Check all to check all filters, and Uncheck all to uncheck all
filters.

Search Enter text here and press < to filter out in the activity stream any item
that does not contain the entered text.

Stream Activity

The stream activity is a list of activity items.
Each activity items consists of:
o The image of the author, the user that performed the activity.

o A description of the activity, with links to the resource pages of the resources
involved in the activity.

o The date and time of the activity.
o Aset of actions to interact with the activity item:

Iltem Description

Like Communicate to other users following the current resource that you like or
approve of the activity.

Reply Opens a text box. Write your reply there and press d to send it.
Share Lets you share the target activity on your person page.

When you click Share, a dialog box opens. You can optionally enter a
Comment. Click Share to share the activity, or Cancel your action.

Flag Flags the target activity as inappropriate, and sends it to the super users for
review.

Delete Deletes the target activity.

(author or

super user)

When you reply to an activity item, Team Server displays your reply right after the target
activity item. A reply consists of:
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Stream

o The image of the author, the user that wrote the reply.

o The name of the author.

o The text that the author wrote as a reply to the target activity item.
o The date and time of the reply.

o If you are the author of the reply, you can click Delete to remove your reply.
Team Server asks you for confirmation before it deletes your reply.

Stream Sidebar

The sidebar in the right-hand side of the Stream page displays different content
depending on the type of resource featured. See Resource Pages.

In general, the sidebar shows a list of activity items somehow related to the current
resource.

See Also

o Posting a Comment to a Resource

o Following a Resource
o Resource Pages
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Discussions

Discussions

The Discussions subpage of glossary pages, term pages, ER object pages, and data
source pages lets social users discuss any resource of one of those types.

To start a new discussion, click New Discussion on the top-right corner.

The list of discussion topic in the page provides the following columns:

Item Description

Expand/Collapse [You can click the + or - button in this column to expand or collapse a
discussion, respectively.

Topic Title of the discussion.

Started By User who started the discussion.

When you expand a discussion, you can see the complete text of the first message of
the discussion, followed by the replies to the discussions, and then by a text field where
you can write your own reply.

Topic Started By Mew Discussion
+  FIFOQ and LIFO Methods Sam
+  Changes to Accounting Estimate Sam
= [mporting current terms Sarah

My team weuld like cur current spreadsheet of terms imported in to this Glossary

Q John 1shall action this. I did this to the Business Glossary last week and it was very easy.
g

Each entry for a reply to the original discussion message displays:
o The image of the author of the reply.
o The username of the author of the reply.
o The actual text of the reply.
o The date when the user wrote the reply.

o If you are the author of the reply, there is a Delete button on the right-hand side
of the reply date that you can click to delete your reply.
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Followers

Followers

The Followers subpage of glossary pages, term pages, person pages, ER object pages,
and data source pages lists the people that is following the current resource.

L

o

! Sarah
ke g_ Sam

See Also

o Working with Glossaries
o Working with Terms

o Interacting with People
o Working with ER Objects

m. John
:!: i

o Working with Data Sources
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Glossary Pages

Glossary Pages

Glossary pages provide information about glossaries: activity, details, terms included,
discussions about them, people who are following them, and child glossaries. They are
only available for social users.

To open a glossary page, follow a glossary link. There are several places where you can
find glossary links, but if you are looking for a specific glossary, you can try the
Glossaries search page.

Glossary pages share a common header, and they also share a common sidebar. When
you click the items in the sidebar, you get access to information pages about different
aspects of the target glossary.

Glossary Pages Header

Business Strategy Newrem J| rolowing

Business Glossary
[Delete]

The glossary page header shows:
o A glossaryicon.
o The name of the glossary.
o The type of resource ("Glossary").

o If you are the owner of the glossary or a super user, you can click [Delete] to
delete the glossary.

On the top-right corner:

o Ifyou are the owner of the glossary or a super user, you can click New Term to
add a new term to the glossary.

o You can click + Follow to start following the current glossary, or Following to
stop following it. See Following Resources.

Glossary Pages Sidebar

Glossary pages provide a sidebar with the following items:
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Glossary Pages

[tem Description
Opens the activity stream of the current glossary.
Stream It displays entries, for example, when a term is associated with the current glossary.
The sidebar shows:
o Followers. A list of users that are following the current glossary. See
the Followers subpage.
o Terms. A list of terms associated with the current glossary. See the
Terms subpage.
o Children. A list of glossaries that are a child of the current glossary.
See the Children subpage.
Provides detailed information about the glossary.
Description
B Shows a list of terms that are associated with the current glossary.
Terms
Opens the list of discussions about the current glossary.
Discussions
Shows a list of users that are following the current glossary.
Followers
" Shows a list of glossaries that are a child of the current glossary.
Children
Opens the users and groups permissions tab for the glossary.
Permissions
See Also

o Working with Glossaries
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Glossary Description

Glossary Description

The Description subpage of glossary pages provides detailed information about a
glossary.

The page is divided in two columns:
o The details column on the left-hand side.

o The stewards column on the right-hand side.

Created by admin on Feb 16, 2015, last edited by admin on Feb 16, 2015 m
Name
Main

Parent Glossaries

Dashboard, System

Status
In progress

Definition

Glossary of terms related with the main office

Abbreviations
Main

Details Column

The details column provides the following fields:
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Item

Author and Date

Edit

Name

Parent Glossaries
Status

Definition
Abbreviations
Aliases/Synonyms

Additional Notes

Glossary Description

Description

On the top of the page, you can see the following text indicating the user
who originally created the glossary, and the date when it was created:

Created by <Author> on <Date>

On the right-hand side of the author and date information, there is an Edit
button that you can click to enter the edition mode.

In the edition mode, you can edit the glossary data, and click Save at the
bottom of the page to save your changes, or Cancel to revert them.

Name of the glossary.

Parents of the glossary.

Text describing the status of the glossary.
Detailed description of the glossary.

List of abbreviations of the glossary.

List of aliases and synonyms of the glossary.

Custom information related to the business object that only you can see.

Other users, including super users, cannot see the information in this field.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the

glossary.

If you are on that list, you can click Edit there to add or remove people from the list.

See Also

o Working with Glossaries
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Children

Children

The Children subpage of glossary pages list the glossaries that have the current
glossary as a parent.

You can use this page to add or remove children of the current glossary.

The page is divided in two tabs:

o The View tab displays a list with the glossaries that are a child of the current
glossary.

o The Manage tab lets you add or remove children from the current glossary.

View Manage

Finance Glossary
Company Glossary

Current Finance Terms, not Exhaustive

Sales Glossary
Company Glossary

Our sales definitions

Manage Tab

The content of the Manage tab is similar to the content of the Glossaries page. For
example, it has a search box as well, and letters to navigate the matching glossaries.

On the right-hand side of the glossary entries, you can click Add Child to make a
glossary a child of the current glossary, or you can click Remove Child to remove the
target glossary from the list of children of the current glossary.

On the top of the list of glossaries, you can click Add All to make all the listed glossaries
children of the current glossary, or you can click Remove All to remove all the listed
glossaries from the list of children of the current glossary.
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Children

l View J Manage ‘

Al ABCDEFGHIIJIJKLMNMNOPQRSTUVWXY Z

Business Strategy Add Child
Common Strategy Terms Used in our Enterprise

Finance Glossary Add Child
Current Finance Terms, not Exhaustive

Sales Glossary Remove Child
Our sales definitions

-EEE

See Also

o Adding a Child to a Glossary
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Term Pages

Term Pages

Term pages provide information about terms: activity, details, discussions about them,
people who are following them, and related glossaries, ER objects and other terms.
They are only available for social users.

To open a term page, follow a term link. There are several places where you can find
term links, but if you are looking for a specific term, you can try the Terms search page.

Term pages share a common header, and they also share a common sidebar. When you
click the items in the sidebar, you get access to information pages about different
aspects of the target term.

Term Pages Header

Marketing

Business Term
[Delete]

The term page header shows:
o Atermicon.
o The name of the term.
o The type of resource ("Term").

o If you are the owner of the term or a super user, you can click [Delete] to delete
the term.

On the top-right corner, you can click + Follow to start following the current term, or
Following to stop following it. See Following Resources.

Term Pages Sidebar

Term pages provide a sidebar with the following items:
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Term Pages

[tem Description
Opens the activity stream of the current term.
Stream It displays entries, for example, when a term is related to a glossary.
The sidebar shows:
o Followers. A list of users that are following the current term. See
the Followers subpage.
o Related Glossaries. A list of glossaries that are related to the
current term. See the Related Glossaries subpage.
o Related Terms. A list of terms related to the current term. See
the Related Terms subpage.
o Related ER Objects. A list of ER object related to the current
term. See the Related ER Objects subpage.
Provides detailed information about the term.
Description
Opens the list of discussions about the current term.
Discussions
Shows a list of users that are following the current term.
Followers
|! Shows a list of glossaries that are related to the current term.
Related
Glossaries
Shows a list of terms that are related to the current term.
Related Terms
ﬂ Shows a list of ER Objects that are related to the current term.
Related ER
Objects
See Also

o Working with Terms

o Working with Glossaries

o Working with ER Objects
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Term Description

Term Description

The Description subpage of term pages provides detailed information about a term.
The page is divided in two columns:

o The details column on the left-hand side.

o The stewards column on the right-hand side.

Created by admin on May 24, 2013 m Stewards [Edit]
Name admin
Hypertext Transfer Protocol

Status
Final

Description
Application protocol for distributed, collaborative, hypermedia information systems,

Abbreviations
HTTP

Aliases/Synonyms

User Data

Details Column

The details column provides the following fields:
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Term Description

[tem Description

Author and Date On the top of the page, you can see the following text indicating the user
who originally created the term, and the date when it was created:

Created by <Author> on <Date>
Edit On the right-hand side of the author and date information, there is an Edit
button that you can click to enter the edition mode.

In the edition mode, you can edit the term data, and click Save at the
bottom of the page to save your changes, or Cancel to revert them.

Name Name of the term.

Status Text describing the status of the term.
Definition Detailed description of the term.
Abbreviations List of abbreviations of the term.

Aliases/Synonyms |List of aliases and synonyms of the term.

Adidtional Notes |Additional information about the business object.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the term.

If you are on that list, you can click Edit there to add or remove people from the list.

See Also

o Working with Terms
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Related Glossaries

Related Glossaries

The Related Glossaries subpage of term pages lists the glossaries related to the term.

If you are a steward of the term, you can use this page to relate or unrelate glossaries to
the term. With the exception of Child Glossaries that are inherited and cannot be
unrelated.

The page is divided in two tabs:
o The View tab displays a list with the glossaries related to the term.

o The Relate tab lets you relate and unrelate glossaries to the term.

View Relate

Finance Glossary
Current Finance Terms, not Exhaustive

Relate Tab

The content of the Relate tab is similar to the content of the Glossaries page. For
example, it has a search box, and letters to navigate the matching glossaries.

On the right-hand side of the glossary entries, you can click Relate to relate a glossary to
the term, or you can click Unrelate to unrelate the target glossary from the current term.

On the top of the list of glossaries, you can click Relate All to relate all the listed
glossaries to the current term, or you can click Unrelate All to unrelate all the listed
glossaries from the current term.
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Related Glossaries

View

All

See

Relate ‘

ABCDEFGHIIJIJKLMNOPQRSTUV

Business Strateqgy

Common Strategy Terms Used in our Enterprise
u Company Glossary

Finance Glossary

Current Finance Terms, not Exhaustive

Also

Associating a Term with a Glossary

Terms page

Working with Terms

Working with Glossaries

W XY Z
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Related Terms

Related Terms

The Related Terms subpage (this subpage is called Terms in glossary pages) lists the
terms related to/from the current resource.

You can use this page to relate or unrelate terms to the current term.
The page is divided in two tabs:
o The View tab displays a list with the terms related to the current resource.

o In ER object pages only, the Found In tab lets you match and unmatch terms to
the current ER object.

o The Relate tab lets you relate and unrelate terms to the current resource.

View Tab

The content of the View Tab is a list of related Terms for the resource that you are
currently viewing. In ER Objects, there will be all the Terms that are related or matched
to the Term. In the Glossary subpage there will be related Terms to the Glossary or to
the Parent Glossary.

Found In Tab

The content of the Found In tab is similar to the content of the Terms page. For
example, it has a search box, and letters to navigate the matching terms.

You can click the Refresh button, right below the list of letters, to perform an automatic
match against existing terms. Team Server automatically matches any term contained by
the current ER object.

On the right-hand side of the term entries, you can click Unmatch to unmatch matching
terms, or click Re-Match to match terms that you manually unmatched.

View Found In Relate

Al ABCDEFGHIIJIJKLMNOPQRSTUVWXYZ

m el & Last auto Match:

Business Terms

E AccountMumber m
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Related Terms

Relate Tab

The content of the Relate tab is similar to the content of the Terms page. For example,
it has a search box, and letters to navigate the matching terms.

On the right-hand side of the term entries, you can click Relate to relate a term to the
current resource, or you can click Unrelate to unrelate the target term from the current
resource.

On the top of the list of terms, you can click Relate All to relate all the listed terms to
the current resource, or you can click Unrelate All to unrelate all the listed terms from
the current resource.

On the Glossary subpage, any Terms that are listed from a Parent Glossary will also be
highlighted with the words (Inherited from Parent Glossary). It is not possible to unrelate
Terms that have been inherited from a Parent Glossary.

View Relate

Al ABCDEFGHIITKLMNOPQRSTUVWXYZ

< previous page 1 2 next page > 10 « items per page

Accounting Period
A period of time, (month, quarter, year), for which a financial statement is
produced.

E Account Name
E Account Number

See Also

o Adding a Term to a Glossary

o Associating a Term with Another Term

o Associating an ER Object with a Term

o Matching an ER Object with Terms
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Related ER Objects

Related ER Objects

The Related ER Objects subpage of term pages lists the ER objects that are either
related to the current term, or that contain the term in their name or other property
values.

You can use the related ER Objects page to relate or unrelate and match or unmatch
ER objects to the current term.

The page is divided in three tabs:
o The View Tab.
o The Found In tab lets you match and unmatch ER objects to the current term.

o The Relate tab lets you relate and unrelate ER objects to the current term.

View Tab

Displays a list of related and matching ER objects. The list shows the related ER objects
first, and then the matching ER objects.

View Found In Relate

= Address
=
== Related Table
Adventure Works12.dm1l > Adventure Works
Street address information for customers, employees, and vendors.

@& ® Address - CustomerAddress
Related Relationship
Adventure Works12.dml > Adventure Works

Found In Tab

The content of the Found In tab is similar to the content of the ER Objects page. For
example, it has a search box as well, and letters to navigate the matching ER objects.

You can click the Refresh button, right below the list of letters, to perform an automatic
match against existing ER objects. Team Server automatically matches any ER object
containing the current term.

On the right-hand side of the ER object entries, you can click Unmatch to unmatch
matching ER objects, or click Re-Match to match ER objects that you manually
unmatched.
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Related ER Objects

Relate Tab

The content of the Relate tab is similar to the content of the ER Objects page as well,
and it also has a search box and letters to navigate the matching ER objects.

On the right-hand side of the ER object entries, you can click Relate to relate a ER

object to the current term, or you can click Unrelate to unrelate the target ER object
from the current term.

On the top of the list of ER objects, you can click Relate All to relate all the listed ER

objects to the current term, or you can click Unrelate All to unrelate all the listed ER
objects from the current term.

View Found In Relate |

ER Objects

AlIABCBDBEFGEGHIIEKELMNOGPRSTUY WXYZ

BillOfMaterials

Adventure Works12.dm1 > Adventure Works

ER Object > Table

Items required to make bicycles and bicycle subassemblies. It identifies the heirarchical...

il

BillOfMaterialsID

Adventure Works12.dm1 > Adventure Works > BillOfMaterials >
PK_BillofMaterials_BillOfMaterialsID

ER Object > Index Column

BillOfMaterialsID

Adventure Works12.dm1 > AW_STAGING > STG_BillOfMaterials
ER Object > Data Lineage Column

Primary key for BillOfMaterials records.

Do

See Also

o Associating a Term with an ER Object

o Matching a Term with ER Objects
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Person Pages

Person Pages

Person pages provide information about users: activity, personal data, people they are
following, people who are following them, and more. They are only available for social

users.

To open a person page, follow a user link. There are several places where you can find
user links, but if you are looking for a specific user, you can try the People search page.

Person pages share a common header, and they also share a common sidebar. When
you click the items in the sidebar, you get access to information pages about different
aspects of the target user.

Person Pages Header

Sarah |- roiow |
Technical Consultant
a admin e

The person page header shows:

o Animage of the user. A default image is shown if the user does not upload an
image.

o The name of the user (not the username).
o The job title of the user.
On the top-right corner:

o If you are viewing your own person page, you can click Edit to open the
Configure Profile page.

o Otherwise, you can click + Follow to start following the current user, or
Following to stop following. See Following Resources.

Person Pages Sidebar

Person pages provide a sidebar with the following items:
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Person Pages

[tem Description

Opens the activity stream of the current user.

Stream It displays entries, for example, when the current user comments on a model
metadata, glossary terms, and domain pages.
Provides detailed information about the user.

Description
Shows a list of users that are following the current user.

Followers
Shows a list of users that the current user is following.

Following

See Also

o Interacting with People
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Configure Profile

Configure Profile

Home | click your name or image | Edit.

admin

User

Profile Picture

l Browse...
Select a JPG, PNG or GIF image from your computer. The maximum file size is 4MB.

From the Configure Profile page you can configure your user profile to share some of
your personal data with other Team Server social users.

You can edit any of the following fields and click Save Changes at the bottom of the

page to save your changes.
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Configure Profile

[tem Description

Photo Click Browse to open a file manager dialog where you can select a local image
file. After you select an image file, click Upload to upload the image to Team
Server and use it as your user image.

Note: Under the Browse button there is a description of the
format and size limitations that Team Server enforces on user
images. If your image does not fit those limitations, uploading
your image fails.

Title Your job title. For example, "Quality Assurance Engineer" or "Technical Writer".

First Name Your first name. For example, "Jane" or "John".

Job A brief description of your job responsibilities.
Description

Phone Your phone number.

Email Your email address.

Stream You can toggle the following options:
Moderation

o "Allow others to post to your stream". Check this option so that
other users can post comments associated with your user.

o "Allow others to comment on activity in your stream". Check this
option so that other users can reply to items in your activity
stream.

See Also

o Configuring Your User Profile

o Stream
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Following

Following

The Following subpage of person pages lists the resources (glossaries, terms, people,

ER objects, data sources) that the user is following.

.
ok admin
Description User
Followers
Following
< previous page 1 next page > 10 |V] items per page
Alert Group 1
Group
Apache

Busmness Terms
Complete removal of an amount due, (usually referring to a tax ABATEMENT a penalty...

Apache
QA

“Complete removal of an amount due

Available space
Metric

© m m g

See Also

o Interacting with People
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User Description

User Description

Title
lane Doe

Name
lane admin

Job Description
Web service administrator

Phone
555-2106

Email

admin@local.com

The Description subpage of person pages provides detailed information about a user.
The page provides the following fields:

Iltem Description

Title User display name.

Team Server displays the user display name in the header of person pages,
below the user name.

Name First and last names of the user.

Job Detailed description of the user's job.
Description

Phone Telephone number where you can reach the user.
Email Email address of the user.
See Also

o Interacting with People
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ER Object Pages

ER Object Pages

ER Object pages provide detailed information about specific ER objects, in addition to
links to related ER objects.

You can access ER object pages by browsing and searching on Team Server.

ER Object pages share a common header, and they also share a common sidebar. When
you click the items in the sidebar, you get access to information pages about various
aspects of the target ER object.

ER Object Pages Header

AccountDescription

Column

Adventure Works12.dml > Adventure Works DW > DimAccount > AccountDescription
Not linked to any term [Create Linked Term)]

The ER object page header shows:

o Animage representing the ER object. A default image is shown if the ER object
cannot be represented by an image.

o The name of the ER object.
o The type of the ER object.

o Breadcrumbs with the ER objects that are above the current ER object in the ER
object hierarchy. Here you can click the parents of the current ER object to
access their ER object pages.

o The Linked Term reference or option to create a Linked Term.

On the top-right corner you can click + Follow to start following the current ER object,
or Following to stop following it. See Following Resources.

ER Object Pages Sidebar

The sidebar in ER object pages provides different items depending on your user type:
social or non-social.

Sidebar for Social Users

When you are a social user, ER object pages provide a sidebar with the following items,
depending on the ER object type:
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Item

Stream

Description

Discussions

Followers

Related Terms

Related Data Sources
(only for physical
models)

0)

Alerts
(only security properties
and attachments)

Permissions

ER Object Pages

Description

Opens the activity stream of the current ER object.

Provides detailed information about the ER object, with links to
related ER objects. This page looks different depending on the type
of the current ER object.

Opens the list of discussions about the current ER object.

Shows a list of users that are following the current ER object.

Shows a list of terms that are associated with the current ER object.

Shows a list of data sources that are associated with the current ER
object.

Lets you configure conditions that raise alerts about sensitive data.

Opens the users and groups permissions tab for the current diagram,
model or submodel.

Note: The Stream, Discussions, and Followers entries in the sidebar of an ER object
page are disabled until you perform some social interaction with the target ER object.
To enable them you can, for example, start following the target ER object.

Non-Social Users

For Non-Social users please see:

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/ER_Object_Pages

See Also

o Working with ER Objects
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Condition Alerts

Condition Alerts

Mew Condition Alert ¥

Show Alert for Matching
# Bound Object
C value
Matching Value
|None 'l
Alert Level
' warning
# Info
Notification Text

Alerts subpage provides detailed information about the conditions alerts that a Security
Property or an Attachment has. If an alert condition matches an ER object, Team Server
displays on the header of an ER object page, the alert message and icon defined in the
alert condition.

You can access the Alerts subpage by clicking the Alerts Icon at the common sidebar
from a Security Property or Attachment page.

This page provides an action on top, New Condition. You can click this action to add a
new alert condition entry to the page.

Super users can edit and delete any alert condition, however authenticated users can
only edit and delete those alert conditions that they create.

Alert Condition Entries

Each alert condition entry in the page provides the following fields:
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Condition Alerts

[tem Description
Show Alert |Here you can define the condition that should result in showing the target alert on
for any matching ER object. You may choose any of the following values:
Matching

o Bound Object. Show the target alert for any object bound to the
current security property or attachment.

o Value. Show the target alert for any object bound to the current
security property or attachment where the security property or
attachment has the specified value. You can specify the target value
on the text input field on the right-hand side of Value.

Alert Level |The level of the alert, which determines which icons Team Server displays along
with the defined Notification Text. You may choose any of the following values:

o Info.

o Notice.

The following image shows the header of an ER object with one alert of each type
and a Notification Text equal to the name of the chosen Alert Level.
ContactCreditCard
Entity
Adventure WorksMNVE.dml > Logical » ContactCreditCard
Mot linked to any termn [Create Linked Term]
*Confidential Information™ Protected under the D.P.A.
®[ustc-m er information
Notificatio |Text of the alert.
n Text Team Server displays this text on the header of matching ER objects, on the right-
hand side of the icon representing the Alert Level.
Delete Deletes the target condition.
Condition
(only super
users and
alert
condition
author)

Note:Team Server saves changes to field values as fields lose focus.

See Also

o

Configuring Sensitive Data Alerts
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ER Object Description

ER Object Description

The Description subpage of ER object pages provides detailed information about an ER
object.

Related Reports Attt

General Properties «

Table Name  JobCandidate

Project Projects

Definition 4

Attributes 4
Keys 4
Security Properties 1

Submeodels 4

The content of the page varies from one ER object type to another. However, when you
are a non-social user, all of them provide the following two sections at the end of the

page:

Iltem Description

Labels Lets you view and manage the current ER object labels.

Comments |Lets you view the comments to the current ER object. You can add, edit or delete
your own comments, or any comment if you are an super user.

This is a list of available ER object description pages:
o ER Object description pages for ER/Studio Data Architect object types:
= Attachment

» Attachment Type

= Attribute/Column

» Bound Attachment

» Bound Data Movement Rule

* Bound Security

* Business Data Object

» Data lineage Column

» Data lineage Source/Target

» Data lineage Table
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ER Object Description

» Data Movement Rule

= Default
= Diagram
= Dictionary

= DL Transformation

= Domain

» Entity/Table
»  Key/Index

* lineage Data Flow

» |ineage Data Stream

= Model

= Reference Value

» Relationship

= Security Property
= Security Type

»  Submodel

= User Datatype

= View

*  View Column
o ER Object description pages for ER/Studio Business Architect object types:

=  BM_Annotation

= BM_Assignment

= BM_Association

» BM_BusinessAttribute

» BM_BusinessElement

=  BM_BusinessEntity

=  BM_BusinessUnit

= BM DataFlement

*» BM_DataObject
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ER Object Description

= BM_DataSource

=  BM_DataStore

» BM_Diagram
= BM_Domain

= BM_Event

» BM_Gateway

= BM_Group
= BM_lane
= BM_Link
» BM_Model

» BM_Message_Flow

= BM_PDiagram
= BM_Pool

= BM_Process

= BM_Project
= BM_Property
= BM_PProperty

» BM_ReferenceColumn

» BM_ReferenceEntity

» BM_Relationship

= BM_Rule

*» BM_Sequence_Flow
*» BM_Steward
* BM_SubjectArea

= BM Task
= BM_Trigger
= BM_Usage

*» BM_Workspace
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Data Source Pages

Data Source Pages

Data source pages provide information about data sources: activity, details, discussions
about them, people who are following them, and related ER models. They are only
available for social users.

To open a data source page, follow a data source link. There are several places where
you can find data source links, but if you are looking for a specific data source, you can
try the Data Sources search page.

Data source pages share a common header, and they also share a common sidebar.
When you click the items in the sidebar, you get access to information pages about
different aspects of the target data source.

Data Source Pages Header

Sales Data

Data Source

The data source page header shows:
o A data source icon.
o The name of the data source.
o The type of resource ("Data Source").

o If you are the owner of the data source or a super user, you can click [Delete] to
delete the data source.

On the upper-right corner:

o You can click + Follow to start following the current data source, or Following to
stop following it. See Following Resources.

Data Source Pages Sidebar

Data source pages provide a sidebar with the following items:

@Note: The Related ER Model tab is available if there is an ER/Studio Team Server
License registered.
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Data Source Pages

[tem Description
Opens the activity stream of the current data source.
Stream Displays entries, for example, when a data source is related to an ER
model.
The sidebar shows:
o Followers. A list of users that are following the current data
source. See the Followers subpage.
Provides detailed information about the data source.
Description
Opens the list of discussions about the current data source.
Discussions
Shows a list of users that are following the current data source.
Followers
Shows a list of ER models that are related to the current data source.
Related ER Models
=} Shows a list of Login Credentials that are related to the current data
Related Login source.
Credentials
Opens the users and groups permissions tab for the data source.
Permissions
See Also
o Working with Data Sources
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Data Source Description

Data Source Description

The Description subpage of data source pages provides detailed information about a

data source.

The page is divided in two columns:
o The details column on the left-hand side.

o The stewards column on the right-hand side.

Details Column

The details column provides the following fields:
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Item

Author and Date

Edit

Name

Definition
Production Level
Location
Application Affinity
Status
Abbreviations
Aliases/Synonyms

Additional Notes

Type

<Database
Management System
Fields>

Custom Properties

Data Source Description

Description

On the top of the page, you can see the following text indicating the
user who originally created the term, and the date when it was created:

Created by <Author> on <Date>

On the right-hand side of the author and date information, there is an
Edit button that you can click to enter the edition mode.

In the edition mode, you can edit the term data, and click Save at the
bottom of the page to save your changes, or Cancel to revert them.

Name of the data source.

Detailed description of the data source.
Production Level of the data source.

Location of the data source.

Application Affinity of the data source.

Status of the data source.

List of abbreviations of the data source.

List of aliases and synonyms of the data source.

Custom information related to the data source that only you can see.

Other users, including super users, cannot see the information in this

field.

Type of database management system (DBMS) of the data source.

The following DBMS are supported: DB2 LUW, DB2 z/OS, InterBase,
Firebird, JDBC, MySQL, ODBC, Oracle, SQL Azure, SQL Server, Sybase,
Sybase 1Q.

Depending on the Type of data source, Team Server displays a different
set of fields between the Type and the Custom Properties fields. See
Data Source Fields for a Specific Database Management System.

Custom properties of the data source. For each property you can see a
property name and an associated property value.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the data

source.

If you are on that list, you can click Edit there to add or remove people from the list.
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Related ER Models

Related ER Models

The Related ER Models subpage of Data Sources lists the ER Models that are either
related to the current Data Source, or that can be related to the Data Source.

You can use the Related ER Models page to relate or unrelate ER Models to the current
Data Source.

The page is divided in two tabs:

View Tab

The View Tab displays a list of related ER Models. The list shows the ER Models currently
related to the selected Data Source. From here you can relate and unrelate ER Models
to the current Data Source.

Orders m

Data Source

Stream

Description

1

Discussions
Followers
View Relate
€3 Related ER Models
Related Login
Credentials
Permissions E_ Orders.dml1 m

ER Object » Physical

Relate Tab

The Relate Tab allows you to relate and unrelate ER Models to the current Data Source.

The Relate tab contains a list of Data Models that can be related to the Data Source.
The list is arranged with alphabetical navigation and contains a search box.

On the right side of the ER object entries, you can click Relate to relate a ER object to
the current Data Source, or you can click Unrelate to unrelate the target ER Model from
the current Data Source.
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Related ER Models

Orders m

Data Source
[Delete]

(@

—_—

v | ree |

Al ABCDEFGHTIIJTKLMMNOPQRSTUVWXYZ

Migration Project (Oracle 8i) Relate
| ! NW.dm1

ER Object > Physical

NW.dm1
ER Object > Physical

D Northwind Production (SQL Server 2000)

See Also

o Data Source Pages
o ERObjects
o Working with Data Sources
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Related Login Credentials

Related Login Credentials

The Related Login Credentials subpage of Data Sources lists the Login Credentials
that are either related to the current Data Source, or that can be related to the Data
Source.

You can use the Related Login Credentials page to relate or unrelate Login Credentials
to the current Data Source.

The page is divided in two tabs:

View Tab

The View Tab displays a list of related Login Credentials. The list shows the Login
Credentials currently related to the selected Data Source. From here you can test
connection to the current Data Source with each related Login Credential. For Test
Connection issues please check troubleshooting guide.

Stream

Orders Hew togin Grogentiss [ foiowins |

Data Source

Dreseription

Discussions
Followers
n Wigw
€D Related ER Models

= Related Login
Y Credentials

Permibssions

Relate Tab

The Relate Tab allows you to relate and unrelate Login Credentials to the current Data
Source.

The Relate tab contains a list of Login Credentials that can be related to the Data
Source. The list is arranged with alphabetical navigation and contains a search box.

On the right side of the Login Credentials entries, you can click Relate to relate a Login
Credential to the current Data Source, or you can click Unrelate to unrelate the target
Login Credential from the current Data Source.
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Related Login Credentials

Data Source

0ot

—_—

= Orders [ new Logn cedentins Jl — ronowing
—

lL View J Relate | ]

Al ABCDEFGHIITKLMNOPQRSTUVWIXY?Z

T

See Also

o Data Source Pages
o Login Credential Pages
o Working with Data Sources
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Group Pages

Group Pages

Groups pages provide information about groups: activity, details, discussions about
them, people who are following them, members, relationships, and permissions.

To open a group page, follow a group link.

Group pages share a common header, and they also share a common sidebar. When
you click the items in the sidebar, you get access to information pages about different
aspects of the target group.

Group Pages Header

."‘" Group 1 [ otowng |
.”.” I::;“itaef:urceGraup
The group page header shows:

o A group icon.

o The name of the group.

o The type of resource ("Data Source Group").

o If you are the owner of the group or a super user, you can click [Delete] to delete
the group.

On the top-right corner, you can click + Follow to start following the current group, or
Following to stop following it. See Following Resources.

Group Pages Sidebar

Group pages provide a sidebar with the following items. The item shown may change
depending on the type of group.
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Group Pages

Item

Description

Stream

Opens the activity stream of the current group.

The sidebar shows Followers (a list of users that are following the current group).
See the Followers subpage.

Description

Provides detailed information about the group.

Discussions

Opens the list of discussions about the current group.

Followers

Shows a list of users that are following the current group.

—
—
—_—

Members

Shows the list of Data Sources or Alerts that are included into the current group
depending of the type of group.

Permissions

Opens the users and groups permissions tab for the group.

See Also

o Working with Groups

o Working with Data Sources
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Group Description

Group Description

The Description subpage of group pages provides detailed information about a group.
The page is divided in two columns:
o The details column on the left-hand side.

o The stewards column on the right-hand side.

Details Column

The details column provides the following fields:

Item Description

Author and Date On the top of the page, you can see the following text indicating the user
who originally created the term, and the date when it was created:

Created by <Author> on <Date>
Edit On the right-hand side of the author and date information, there is an Edit
button that you can click to enter the edition mode.

In the edition mode, you can edit the term data, and click Save at the
bottom of the page to save your changes, or Cancel to revert them.

Name Name of the term.

Status Text describing the status of the term.
Definition Detailed description of the term.
Abbreviations List of abbreviations of the term.

Aliases/Synonyms |List of aliases and synonyms of the term.

Additional Notes |Additional information about the business object.

Stewards Column

The stewards column provides a list of Stewards, users with permission to edit the data
source.

If you are on that list, you can click Edit there to add or remove people from the list.

See Also

o Working with Data Sources

o Data Source Fields for a Specific Database Management System
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Login Page

Login Page

The Login page lets you enter your user credentials to access an Team Server
installation.

You can only open this page if you are not currently logged in to Team Server. To

access this page, open http://teamserver.example.com/Login in a web browser (replace
"http://teamserver.example.com" by the actual URL of your Team Server installation).

This page provides the following items:
Item Description
Username Your username to access Team Server.

Password Your password.

Remember |Check this option to make Team Server remember you for a week, so that you do

me not need to enter your user credentials again during that period.
Log In Click this button to access Team Server.
See Also

o Connecting to Team Server

Embarcadero Technologies 71


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Connecting_to_Team_Server
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Connecting_to_Team_Server
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Connecting_to_Team_Server

Navigation Menu

Navigation Menu

The main navigation menu provides items to give you access to the main features of
Team Server.

The availability of the items in the navigation menu changes depending on your license
type:

Basic and Performance 1Q Navigation Menu

This are the available features on the navigation menu when you do not have any license
registered yet and when you have a Performance 1Q license registered:

Home People DataSources

The navigation menu when you have no registered license allows you to have access to
the following items:

Item Description
Home See recent activity of ER objects and people that your are following.
People Search for users.

Data Sources Search and manage Data Sources. Including Login Credentials.

ER/Studio Navigation Menu

When you have an Team Server license registered, you will access to the basic features
explained previously and also to the following items:

Home Glossaries Terms People ERObjects ERTools Data Sources

ltem Description
Glossaries |Search for glossaries.
Terms Search for terms.

ER Objects |Search for ER objects of the Reporting Repository.

ER Tools  |Lets you navigate to the business and technical reports and create custom reports.
From here you can also access your favorite and shared searches and reports.

Data Search and manage Data Sources, including the capability of relating models.
Sources
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Navigation Menu

See Also

o Overview of User Experiences
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Report Pages

Report Pages

Report pages provide the results of a report in HTML format.

At the top of the page you can access the following actions:
Action Description

View as pdf |Downloads the report as a PDF file.

View as xls |Downloads the report as an XLS file, that is, a Microsoft Excel spreadsheet.

Tip: To print the HTML version of the report, use the printing function of your web
browser. In most web browsers, you can press Ctrl + P to open the printing function.

Report Pages
This is a list of available report pages:
o Reports that super users can open from the Activity page:
* Login Activity Details
» Updated Object Details
» Connection Activity Details
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Connection Activity Details

Connection Activity Details

My Settings > Activity | click a bar in the Connection Activity graphic (super users)
In this report you can see a list of connections established during a specific time frame.

The report contains the following columns:

Column Description
User Name The name of the user that connected.
Host The hostname of the machine from which the user connected.
IP The IP address of the access point from which the user connected.
Login Time The date when the user session started.
Logout Time The date when the user session ended.

Connection Type |The connection type that the user consumed.

See Also
o Activity

o Login Activity Details
o Updated Object Details
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Login Activity Details

Login Activity Details

My Settings > Activity | click a bar in the Login Activity graphic (super users)
In this report you can see the login activity during a specific time frame.
The report contains the following columns:
Column Description
User Name The name of the user that logged in.
User Description |The description of the user that logged in.
Login Time The date when the user session started.

Connection Type | The connection type that the user consumed.

See Also
o Activity

o Connection Activity Details
o Updated Object Details
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Updated Object Details

Updated Object Details

My Settings > Activity | click a bar in the Updated Objects graphic (super users)

In this report you can see a list of update events that affected ER objects of a specific ER
object type during a specific time frame.

The report contains the following columns:

Column Description

Event Date |The date when the update event took place.

Parent The name of the parent of the updated ER object. You can click the parent name
Name to access its ER object page.
Name The name of the updated ER object. You can click the ER object name to access

its ER object page.

User Name |The name of the Team Server user that modified the ER object.

Operation |The type of operation applied to the ER object.

See Also
o Activity

o Connection Activity Details

o Login Activity Details
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Search Pages

Search Pages

Search pages let you search for a certain type of resources within Team Server:
glossaries, terms, people, ER objects, etc.

Search pages are only available for social users, and you can open them from the
navigation menu.

Although some of them provide additional buttons in the body, all search pages have
the same body and sidebar. The search filters may change slightly depending on which
resource you are viewing.

ikl Terms
e oo
P Favorite Searches Al A B CDEFGHIJEKLMNODODPQRSTUY WXYZ m
O « previous page 12 3 mext page * [10 [ iterns per page
B Name
M status Adventure Works [Adventure WorksTorquil.DM1)

B Abbreviations Madel (Linked Term)

& Alises/Symaryms
DheFinstson
[ additional Notes

b Custom Attributes E

Adventure Works DW [(Adventure WorksTorquil 2.0M1)
Made| (Linked Term)

Filter By: Apache

Business Terms

Terms (25) Complete rernoval of an armaunt due, (usually referring 1o a tax ABATEMENT a penalty...

odel (Linked Term) (3)
QA1)

Co'nple e removal of an amount due

(15} Human Resources [Adventure WorksTorquil3.DML, Adventure Works)
E Submaosdel (Linked Term)

For a list of search pages, see the following index.

Search Page Body

The body of every search page contains a header with at least the following items:
o The title of the search page.

o Asearch box to search for resources of the type of the search page. Global
searches do not provide this field, as you can use the global search box instead.

o Alist with all the letters in the alphabet. You can click any of the letters to show in
the search results only those resources beginning with the chosen letter. At the
beginning of the list, you can click the All option to disable the filter.

Al ABCDEFGHTIJKLMMNOGPQRSTUVWXY Z

Below the header there is the list of search results. Each search result provides at least
the following information:
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Search Pages

o Anicon representing the resource.

o The name of the matching resource. You can click the name to open a page with
details about the matching resource.

o On the right-hand side of each search result, there is an action area which might
show any of the following:

= A + Follow button to start following the target matching resource.

* A Following button that indicates that you are following the matching
resource. You can click this button to stop following the target matching
resource.

= Nothing, if you cannot follow the matching resource. For example, you
cannot follow yourself, so your user entry when searching for people does
not show any button.

Search In: Search Results: home
HHame
B status Al ABCDEFGHIJKLMNOPQRSTUVWXYZ
[ Abbreviations
E.ﬂ.hasm"sxl.lnunyms
M pefinition — Phn_Role m
Onaes Orders.dml > Orders
A General Properties ER Object > Table
BA Custom Attributes The type of phone number, such as business, home or fau
Filter By: Phone Role m

E Ing (2) Orders.dml > Logical
vortiing £ £R Object > Entity

- The type of phone number, such as business, home or fax
€ ER Objects () 4 vpeete - e

In most search pages, under the name of the matching resource additional information
about the resource is provided.

GIMDBZ2.dml > Logical > Client Fact

ER Object » Attribute

When the number of search results is greater than the default number of search results
to display on each search page, a pagination bar is displayed both before and after the
list of search results:

%]
[T¥)

< previous page 1 next page > 10~ items per page

This pagination bar provides the following items:
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Search Pages

[tem Description
< previous |Loads the previous page of search results.
page

123.. In the center of the pagination bar, there is a list of page numbers, a number for
each page of search results (until you reach a certain limit).
You can click any number to load the target page of search results. For example,
click 3 to load the third page of search results.

next page > |Loads the next page of search results.

items per Choose from the combo box the number of results per page that you want to see:
page 10, 20, 50, or 100.

Search Page Sidebar

The sidebar of search pages shows different content depending on whether you are
performing a global search or searching for a specific type of items.

Search In:

@ Name

M Status

E Abbreviations

% Aliases/Synonyms
M Definition

[ Notes

M General Properties
M Custom Attributes

Filter By:
Everything (154)
E Terms (64) 1

€3 ER Objects (89)

Global Search Page Sidebar

When you perform a global search, the left-hand sidebar provides two different sections:
Search In and Filter By.

Under Search In there is a list of resource fields or field groups that you can search
depending on the resource you are viewing:

o Name

o Aliases/Synonyms
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Search Pages

o Definition

o Notes (searching includes both notes and additional notes)
o General Properties

o Custom Attributes

Note: For more effective searching, not all fields will be available to search for every
resource. For example, when searching People, Terms, Glossaries, or Data Sources, the
fields for Notes or General Properties are not included. When searching for People or
ER Objects the search field for Aliases/Synonyms is not available.

You can check or uncheck any entry in the list. When you toggle an entry, Team Server
repeats the search, and searches only those entries that are checked in the list.

Under Filter By there is a list of the types of resources that match the current search.
You can click a resource type so that the search results include only resources of the
selected type.

The first entry in the filter list, Everything, is selected by default when you start a global
search, and does not filter the search results by resource type.

The ER Obijects resource type, when listed under Filter By, has an icon on the right-
hand side: 4. You can click that icon to display a list of subtypes (types of ER objects),
and you can click any subtype to filter the search results by that type of ER object.

Resource-specific Search Page Sidebar

The sidebar of search pages for specific types of resources always contains the following
two entries:

o All <Search Page Name>. Lets you search for any resource of the type of the
search page.

o My <Search Page Name>. Lets you search only for resources of the type of the
search page that you are following.

o Favorites Searches. Provides a list of searches that you set and save as favorite,
as well as public searches stored by other users.

Where <Search Page Name> is the name of the search page, such as Glossaries or ER
Objects.

All Glossaries
My Glossaries

Favorite Searches
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Search Pages

Search Pages Index

The following search pages for specific types of resources are available:

o Glossaries

o JTerms
o People

o ERObjects

o Data Sources

See Also

o ER Object Pages

o Navigation Menu
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Glossaries

Glossaries

The Glossaries page is a search page that lets you search for glossaries, create new
glossaries or load them from a CSV file.

On the upper-right corner you can access the following commands:

Iltem Description
New Glossary Opens the New Glossary dialog box to create a new glossary.

Export Glossaries |Allows you to export glossaries and terms to a CSV file.

Load Glossaries |Opens the Load CSV File page to load glossaries and terms from a CSV file.

Glossary Tool Tip |Opens the Glossary Tool Tip start page.

See Also

o Searching for a Resource of a Specific Resource Type

o Search Pages
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Load CSV File

Load CSV File

Choose a File

Glossaries | click Load Glossaries

The Load CSV File page provides a field, Choose a File, where you can specify the
path to a CSV file of glossaries and terms that you want to load.

After you choose the path to the target CSV file, click Load to actually load the file.
Team Server reloads the page and displays information about the glossaries and terms
added or modified as a result of loading the CSV file.

See Also

o Loading Glossaries and Terms from a CSV File
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New Glossary

New Glossary

New Glossary x

Name
Parent Glossary

Status

Description

Csove [ concer

Glossaries | click New Glossary

The New Glossary dialog box provides a set of fields that you can use to define a new
glossary.

After you finish filling the information about the new glossary, you can click Save to
create your new glossary. You can click Cancel at any moment to abort.

These are the fields that you can fill in this page:
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New Glossary

[tem Description

Name The name of the glossary.

This is the only field required to create a new glossary. As soon as you fill the
Name, you can click Save. You can edit any other details later.

Parent An existing glossary that is a parent of the new glossary.

Glossary As you write, Team Server offers names of existing glossaries for
autocompletion. After you write the name of the parent glossary, click Add to
actually select it.

After you select a parent glossary, you can click # on the right-hand side of the
parent glossary name to remove it, so that you can select a different parent
glossary.

Status Text that describes the status of the glossary using nomenclature you decide
upon.

You can use for example the following nomenclature: "Approved”, "Not Yet

Approved", "Implemented”, "Not Yet Implemented", and "Deprecated".
Description |Detailed information about the glossary, such as its purpose and audience.
See Also

o Creating a Glossary
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Terms

Terms

The Terms page is a search page that lets you search for terms or create new terms.

On the upper-right corner you can access the following command:

[tem Description

New Term |Opens the New Term dialog box to create a new term.

See Also

o Working with Terms

o Search Pages
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New Term

New Term

New Term x

Name

Term Entity Type

Status

Related Glossaries

Definition

-

(sove | cance

Terms | click New Term

The New Term dialog box provides a set of fields that you can use to define a new term.

After you finish filling the information about the new term, you can click Save to create
your new term. You can click Cancel at any moment to abort.

These are the fields that you can fill in this page:
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People

[tem Description

Name The name of the term.

This is the only field required to create a new term. As soon as you fill the Name,
you can click Save. You can edit any other details later.

Status Text that describes the status of the term using nomenclature you decide upon.

You can use for example the following nomenclature: "Approved", "Not Yet
Approved", "Implemented”, "Not Yet Implemented", and "Deprecated".

Related Existing glossaries that are related to the new term.

Glossary As you write, Team Server offers names of existing glossaries for

autocompletion. After you write the name of a glossary, click Add to add it to the
list of related glossaries.

After you select a related glossary, you can click # on the right-hand side of the
glossary name to remove it.

Description  |Detailed information about the term, such as its purpose and audience.

See Also

o Creatinga Term

People

The People page is a search page that lets you search and create new Team Server
users.

See Also

o Interacting with People

o Search Pages

ER Obijects

The ER Obijects page is a search page that lets you search for ER objects.

See Also

o Searching for a Resource of a Specific Resource Type

o Search Pages
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Data Sources

Data Sources

The Data Sources page is a search page that lets you search for data sources or create
new data sources or groups of them.

To use the Data Source Advanced Search feature, click the link to the right of the search
box.

On the upper-right corner, you can access the following command:

Item Description

New Data Source |Opens the New Data Source dialog box to create a new data source.

New Group Opens the New Group dialog box to create a new group.

Advanced Search Feature

The data source advanced search feature allows you to add one or more search filters to
narrow your search criteria.

o Use the dropdown list to select the fields that you want to search. For example,
Name or Location.

o Use the next dropdown list to either match, not match, or find similar items.
o Use the text box to enter your search criteria. The search is not case-sensitive.
Using the add filter “Ficon allows you to use multiple search filters at one time.

You can save search filters with the Save Filter As button or load previously saved filters
with the Load Filter button.

See Also

o Working with Data Sources

o Working with Groups

o Search Pages
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New Data Source

New Data Source

Data Sources | click New Data Source

The New Data Source dialog box provides a set of fields that you can use to define a
new data source.

After you finish filling the information about the new data source, you can click Save to
create your new data source.
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You can click Cancel at any moment to abort.

See Also

o Creating a Data Source
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User Menu

User Menu

The user menu lets you access to features that are specific to your user, and lets you
customize your personal settings.

The user menu contains two items:

o My Settings. Hover this item to show a context menu with additional menu
items.

o Log Out. Logs you out of Team Server, ending your current user session.

My Settings Context Menu Items

[tem Description
Help Displays the online help.
Preferences Lets you define your email address, as well as your search and filtering
preferences.

Configurator |Lets you to change the settings that you decided when you first install and
configure Team Server and Repository.

Admin Gives you access to administrative functions. Manage licenses, permissions,
publications, and more.

Activity Displays graphics of login activity, connection activity, and ER object history.
You can click the bars on the graphics to access detailed reports.

SystemSettings |Gives you access to social administrator configuration.

Notifications |Lets you configure your notification settings.

Non-Social Users

For Non-Social users, please see: User Menu.

See Also

o User Guide

Embarcadero Technologies 92


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Preferences
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Embarcadero_Team_Server_Configuration_Manager
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Admin
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Overview_of_Connection_Licenses
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Access_Control_Permissions
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/ER/Studio_Publications
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Activity
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/SystemSettings
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Notifications
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/User_Menu
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/User_Guide

Activity

Activity

My Settings > Activity (super users)

On this page you can see who is logged in to Team Server, view login denials, API
connections and display a historical chart of connection activity.

This page provides the following graphics:

o Denials
o Users
o APl Usage

o Web Site Usage

Denials

This graphic shows the denials in a time period. To see further information, click in a
graph node to pop up a dialog with the information about the denials, including User
Name, Login Type and the Time of Denial.

You can enter a start and an end date, and click Go to update the graphic so that it
reflects the specified time period.

When you hover the pointer over a node representing activity for a specific day, Team
Server displays information about the graph node.

Users

This graphic shows the number of active Users in a cumulative chart by day in a time
period. Also depicted is the Max Number of Licenses, showing the maximum allowed
users.

Clicking on a node pops up a separate dialog with detailed information of User Name,
Login Type, License, and Time.

If you hover your mouse over a node, it will pop up a tooltip giving specific information.
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Activity

Users From: 01/30/2014 Te: 02/04/2014 Go

Max Mumber of Licenses
Ml Users
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This Chart shows the active users in the system.

APl Usage

This graphic shows the logins by license type and the total logins in a time period by
API.

Clicking on a bar pops up a separate dialog with detailed information of User Name,
Login Type, License, and Time.

If you hover your mouse over a node, it will pop up a tooltip giving specific information.

You can enter a start and an end date, and click Go to update the graphic so that it
reflects the specified time period.

Web Site Usage

This graphic shows the logins by license type and the total logins in a time period.

You can select which license type, Connect or Portal to be displayed on the bar graph,
by changing the drop-down list.

If you hover your mouse over a node, it will pop up a tooltip giving specific information.

You can enter a start and an end date, and click Go to update the graphic so that it
reflects the specified time period.

See Also

o Tracking User Activity

o Overview of Connection Licenses
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Working with Resources

Working with Resources

Team Server gives you access to various types of resources:

o Glossaries

o JTerms
o People

o ERObjects

o Data Sources
o Groups
The following topics are shared by more than one type of resource:

o Searching for a Resource of a Specific Resource Type

o Editing a Resource

o Discussing Resources

o Following Resources
o Editing the Stewards of a Resource
o Adding an Attachment Attribute to a Resource Type

o Loading Glossaries and Terms from a CSV File

o Deleting a Resource

See Also

o Resource Pages
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Adding an Attachment Attribute to a Resource Type

Adding an Attachment Attribute to a
Resource Type

You can associate enterprise data dictionary attachments with the following Team Server
resource types: glossaries, terms, people, data sources, and the following ER objects:
tables, columns, logical entities, logical attributes, business entities and business
attributes.

When you associate an attachment to a resource type, the Description subpage of the
pages of that type of resource include the associated attachment as a custom attribute
which you can edit from Team Server.

To associate an enterprise data dictionary attachment with a resource type:

1. Select My Settings > Admin > Managed Attributes.

2. Select the tab of the target type of resource. For example, Data Source.

3. On the left-hand side column, click an attachment to select it.

4. Click the ' icon to add the selected resource to the right-hand side column.

The selected attachment is now associated with the current resource type.

See Also

o Resource Pages
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Deleting a Resource

Deleting a Resource

You can delete a resource as long as you are its original author (the user who creates the
resource), a stewards of the resource, or a super user.

To delete a resource of any of those types:

1. Open the page of the target resource. You can search for it.

2. On the resource page, click [Delete] on the header.

3. On the confirmation dialog box that opens, click OK.
The target resource is not available anymore in Team Server.

Note: Deleting a resource does not delete the resources that are related to it. For
example, if you delete a glossary, any term associated with it remains in Team Server.

See Also

o Creating a Glossary

o Creatinga Term
o Creating a Data Source
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Discussing Resources

Discussing Resources

Team Server lets you keep discussions with other Team Server users about any resource
(glossaries, terms, ER objects, and data sources).

You can access the discussions about a specific resource from the Discussions subpage
of the target resource page.

Topics

o Starting a Discussion about a Resource

See Also

o Following Resources
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Starting a Discussion about a Resource

Starting a Discussion about a
Resource

To start a discussion about a resource:

1. Open the page of that resource.

2. Openthe ' Discussions subpage.

3. Click New Discussion on the top-right corner.

4. On the New Discussion dialog that opens:
1. Write the discussion title in the upper, one-line field.
2. Write your initial discussion message inside the multi-line text field.
3. Click Create to start the discussion.

Your new discussion topic is added to the list of topics in the Discussions page so that
other people can see it and join the discussion.

See Also

o Discussions page

Embarcadero Technologies 99


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Resource_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Discussions
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Discussions
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Discussions

Editing a Resource

Editing a Resource

To edit a resource:

1. Open the page of the target resource. You can search for it.

2. Open the == Description subpage.

3. Click Edit to enter the edit mode. In edit mode, the Description page provides
fields to define the values of each property of the target resource.

4. Modify the resource properties.

Tip: For information about the fields that you can edit, check the documentation of the
description page of the type of resource that you are editing.

5. To save your changes, click Save at the end of the page.

@Note: To automatically update any matched items to the edited changes, the Auto
Match tick box on the Found In tab must be enabled.

See Also

o Editing the Stewards of a Resource
o Working with Glossaries

o Working with Terms

o Working with Data Sources
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Editing the Stewards of a Resource

Editing the Stewards of a Resource

To add or remove stewards from a resource:

1. Open the page of the target resource. You can search for it.

2. Open the == Description subpage.

3. Click Manage on the right-hand column, on the right-hand side of Stewards, to
enter the edit mode.

4. In edit mode, you can:

*  Enter the name of a user into the text field and click the name that
appears to add that user to the list of stewards.

= Click # on the right-hand side of an existing steward to remove that user
from the list of stewards.

5. To save your changes, click the Save button below the steward list. If you want to
discard changes, click Cancel.

@Note: Only the users with the super user role, steward, and users with steward
permission will be able to manage the stewards of it.

See Also

o Overview of Stewards

o Editing a Resource
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Following Resources

Following Resources

Team Server keeps track of people activity surrounding resources (glossaries, terms, ER
objects, and data sources). It records when someone edits a resource, posts a comment
to a resource, and so on.

You can follow a resource so that you can keep track of all the activity that surrounds
that resource. You can see the activity of every resource that you are following in your
Home page.

Topics

o Following a Resource

o Posting a Comment to a Resource

o Unfollowing a Resource

See Also

o Discussing Resources
o Stream page
o Followers page
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Following a Resource

Following a Resource

To start following a resource:

1. Open the page of that resource. You can try searching for it.

2. Click + Follow on the upper-right corner of the resource page header.

You are now following the resource, and its activity is displayed in your Home page.

See Also

o Unfollowing a Resource

Posting a Comment to a Resource

You can post a comment to a Team Server resource (glossaries, terms, ER objects, and
data sources) so that people following that resource is notified, and anyone can read
your comment in the Stream subpage of the resource page.

To post a comment to a resource:

1. Open the page of that resource.

2. Open the = Stream subpage.

3. Write your comment into the field with the text "Write a comment...", and
click < to send your comment.

Team Server adds your comment to the Stream page, and notifies any user following the
resource.

See Also

o Following a Resource

o Stream page
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Unfollowing a Resource

Unfollowing a Resource

To stop following a resource:

1. Open the page of that resource. You can try searching for it.

2. Click Following on the upper-right corner of the resource page header.

You are not following the resource anymore , and its activity is no longer displayed in
your Home page.

See Also

o Following a Resource

Manage User Permissions on a
Resource

To manage User Permissions:
1. Select the Permissions page and then select the Users tab.
2. Click the Edit button on the upper-right corner.
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Manage User Permissions on a Resource

The Manage User Permissions page shows a permissions table where you can set
specific permissions for Glossaries, ER Objects, Datasources, Login Credendials, Reports
and Applications.

It shows the following options for each element type:

[tem Description
List/View Check this option to allow read-only permissions.
Create Check this option to allow creating the resources.

Update/Delete |Check this option to allow editing and deleting the resources.

Stewards Check this option to allow user to manage the Stewards of a resource.

The Groups Membership table allows you to include the user on permissions groups.

Click the Save button to save your settings.

See Also

o Admin

o Manage Group Permissions on a Resource

o Deleting a Permissions Group
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Manage Group Permissions on a Resource

Manage Group Permissions on a
Resource

To manage Groups Permissions:
1. Select Permissions page and then select Groups tab.
2. Click the Edit button on the upper-right corner.
Permissions
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The Manage Groups Permissions page shows a permissions table where you can set
specific permissions for Glossaries, ER Objects, Datasources, Login Credendials, Reports
and Applications.

It shows the following options for each element type:
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Manage Group Permissions on a Resource

[tem Description
List/View Check this option to allow only read permissions.
Create Check this option to allow creating the resources.

Update/Delete |Check this option to allow editing and deleting the resources.

Stewards Check this option to allow user to manage the Stewards of a resource.

The Members table allows you to include the user on permissions groups.
You can also modify the name and the description of the group on this page.

Click Save button to save your settings.

See Also
o Admin

o Manage User Permissions on a Resource
o Deleting a Permissions Group
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Interacting with People

Interacting with People

You can interact with social users (people) as you interact with any other Team Server
resource. They have their own search page, resource page, and subpages, and so on.

To see the details of a user, find it and open its person page.

Topics

o Creating a New User

o Editing an User

o Searching for a User

o Following People

o Adding an Attachment Attribute to People

o Deleting an User

See Also

o People search page

o Person Pages
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Loading Glossaries and Terms from a CSV File

Loading Glossaries and Terms from a
CSV File

You can load into Team Server, glossaries and terms from CSV file if you have a CSV file
that follows the required format.

To load glossaries and terms from a CSV file:

1. Select Glossaries on the navigation menu.

2. Click Load Glossaries on the upper-right corner of the Glossaries page.
3. On the Load CSV File page that opens:
1. Click Browse and choose the target CSV file.

2. Click Load.

Team Server loads the glossaries and terms on the CSV file.

@Note: If you have any formatting errors in your csv file, you may receive an error
message. The log file that you can check for any import errors is located at:
.\Embarcadero Team Server 2016\logs\ersportal.log

See Also

o Creating a Glossary

o Creatinga T Term
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CSV Format to Load Glossaries and Terms

CSV Format to Load Glossaries and
Terms

Team Server can load CSV (comma-separated values) files containing information about
glossaries and terms as long as they follow the expected format.

Later in this topic there are some examples of the format required to import either
Glossaries or Terms.

Each set of rows contains four or more rows with the following content:

o The first row contains a fixed value, the start tag, which depends on the type of
resource:

» |If you want to define a glossary: +++ Glossaries Begin +++.
* If you want to define a term: +++ Terms Begin +++.

o The second row contains a comma-separated list of the names of properties of
the target type of resource that we want to define later. Only the resource name
is mandatory.

o Between the second row and the last row you can insert as many rows as you
want. Each one of the rows represents a single glossary or term, and contains a
comma-separated list of property values for that resource. The order that you
have to use to specify the resource property values is that of the property names
in the second row.

o The last row contains a fixed value, the end tag, which depends on the type of
resource:

» Ifyou defined a glossary: +++ Glossaries End +++.

* Ifyou defined a term: +++ Terms End +++.

See also the examples of CSV files below.

Properties that You Can Use in Your CSV File

The property names that you can use on the second row of a set depends on whether
your set defines a glossary or a term.
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CSV Format to Load Glossaries and Terms

Glossary Properties

[tem Description

Key This value is filled when exporting existing glossaries and terms. Updating
with the key allows you to modify the glossary without creating new ones.
The Key field is left empty when creating new glossaries.

Name Name of the glossary.

(mandatory)

Status Chosen status (this is a status of the glossary that is predefined by you).

Stewards List of usernames of Team Server users that must become stewards of the
new glossary.
Separate values with a semicolon. For example: usernamel; username?.

Definition Definition of the new glossary.

Abbreviations

An abbreviation of the glossary.

Aliases

An alias for the glossary.

AdditionalNotes

Anything you would like to define in the Additional Notes section of your
glossary.

ParentGlossary

Name of the parent glossary, in case you wish to structure your Glossary as
a child of another glossary.

[CustomAttributes]

Indicate the name of a custom attribute in the column header and value in a
row. A custom attribute should be assigned to glossaries in advance or it
will be ignored.
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CSV Format to Load Glossaries and Terms

Term Properties
[tem Description

Key This value is filled when exporting existing glossaries and terms. Updating
with the key allows you to modify the term without creating new ones. The
Key field is left empty when creating new terms.

Name Name of the term.

(mandatory)

Status Chosen status (this is a status of the term that is predefined by you).

Stewards List of usernames of Team Server users that must become stewards of the
new term.

Separate values with a semicolon. For example: usernamel ; username?2.

Definition Definition of the new term.
Abbreviations An abbreviation of the term.
Aliases An alias for the term.

AdditionalNotes  |Anything you would like to define in the Additional Notes section of your
term.

RelatedGlossaries |Name of any related glossaries.

Separate values with a semicolon. For example: Glossaryl;Glossary?2.

RelatedTerms Name of any related terms.
Separate values with a semicolon. For example: Terml; Term2.

TermEntityType  |Name of the Term Entity Type. This can be predefined by you when
creating terms, or from the Term Entity Types subpage of the admin
pages.

[CustomAttributes] |Indicate the name of a custom attribute in the column header and value in a

row. A custom attribute should be assigned to glossaries in advance or it
will be ignored.

@Note: Please note that linked terms cannot be updated.

Custom Attributes

The custom attributes format depends on the type.
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CSV Format to Load Glossaries and Terms

Type Format Example
Date MM/DD/YYYY 01/23/2013
Boolean True or False True
Time HH:MM:A 01:25 PM
Numeric Integer Number 364
External File Path |String \\servernamel\file.txt
Text String Some Text
Text List String and matching valid values [Value1

Examples of Valid CSV Files

These are some example CSV files that you can load into Team Server.

Single Glossary

The following CSV code defines a single glossary named "Accounting”.

+++ Glossaries Begin +++

Key,Name, Status,Definition,Abbreviations,Aliases,AdditionalNotes, Stewards,,,,,,
rrs

,Accounting, Approve, "Glossary of commonly used accounting
terms-”rrrladmj-nllllllll

+++ Glossaries End +++

Terms

The following CSV code defines terms named "AMT" and "Abatement".

+++ Terms Begin +++

Key,Name, Status,Definition,Abbreviations,Aliases,AdditionalNotes, Stewards,Relat
edGlossaries,RelatedTerms, TermEntityType

,AMT, Approved, "Tax imposed to back up the regular income tax imposed on
CORPORATION and individuals to assure that taxpayers with economically measured
income exceeding certain thresholds pay at least some income
tax.",,,,admin,Accounting,,

,Abatement, Approved, "Complete removal of an amount due, (usually referring to a
tax ABATEMENT a penalty abatement or an INTEREST abatement within a governing
agency).",,,,admin,Accounting, AMT,

+++ Terms End +++

@Note: When relating more than one term to another, term entity types must be

specified with the format
"RelatedTermName1,TermEntityType1";"RelatedTermName2, TermEntity Type2".
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Searching for a Resource of a
Specific Resource Type

To search for resources of a specific resource type:
1. Select the search page of the target resource type.
2. Enter your search terms in the search field.

As soon as you stop typing, Team Server filters the list of resources and displays only
resources that meet your search criteria. Click their name to open their resource page.

Advanced Search

Using the advanced search you have more control of the search than with any other
search box in ER/Studio Team Server. For advanced search:

1. Click the Advanced button search page of the target resource.

2. In the Property drop-down list select the property you want to filter for.
3. Select the condition: Is, Like, Not Like...
4

In the Value field, enter a valid value for the selected property. This will limit the
search results.

5. Click Search. The Advanced Search page reloads to show the search results.

If you need to add additional filters, click the “Fbutton on the right-hand side of the first
set of filter fields.

Favorite Searches

After completing an advanced search, you can name and save the search for later use.
To save an advanced search as favorite:
1. Perform an advanced search.
2. Click Save Search As.
3. On the New Search dialog box that opens:
* Enter a descriptive Name for your search.

»  Optionally, write a Description that provides additional details that
would not fit the search name.

» Optionally, check the Shared checkbox to make your new favorite search
public, so that any other user can access your search from the Favorite
Searches page. If you leave this option unchecked, you will be the only

Embarcadero Technologies 114


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Search_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Resource_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Search_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Searching_for_a_Resource_of_a_Specific_Resource_Type#Advanced_Search
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Favorite_Searches_for_a_Specific_Resource_Type
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Favorite_Searches_for_a_Specific_Resource_Type

Searching for a Resource of a Specific Resource Type

user able to access your new favorite search from the Favorite Searches
page.

After you save your new Advanced Search as favorite, you can find it in the Favorite
Searches page.

See Also

o Search Pages
o Global Search Box
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Working with Glossaries

Working with Glossaries

Glossaries are collections of terms, such as "Human Resources"”, "Travel Department”,
or "Customer Service". Glossaries can contain many terms, and each term can be
associated with many glossaries.

When you create a glossary or load them from a CSV file, you become its owner. Only
you or a super user can add terms to it or delete it.

To see the details of an existing glossary, find it and open its glossary page.

Topics

o Creating a Glossary

o Loading Glossaries from a CSV File

o Searching for a Glossary

o Editing a Glossary

o Adding a Term to a Glossary
o Adding a Child to a Glossary
o Discussing Glossaries
o Following Glossaries

o Editing the Stewards of a Glossary

o Adding an Attachment Attribute to Glossaries

o Deleting a Glossary

o Glossary Tool Tips

See Also

o Glossaries search page

o Glossary Pages

o Working with Terms
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Adding a Child to a Glossary

Adding a Child to a Glossary

To make an existing glossary a child of another glossary:

1. Open the page of the parent-to-be glossary. You can search for it.

2. Open the Bchildren subpage.
3. Open the Manage tab.

4. In the list of existing glossaries, click Add Child on the right-hand side of a
glossary to add as a child of the current glossary.

* You can use the search field at the top of the page to filter the list of existing
glossaries.

*  You can click Remove Child on right-hand side of a glossary, on any of the tabs,
to remove the glossary from the list of children of the current glossary.

See Also

o Creating a Glossary
o Children subpage
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Adding a Term to a Glossary

Adding a Term to a Glossary

To add existing terms to a glossary:

1. Open the page of the target glossary. You can search for it.

2. Open the BTerms subpage.
3. Open the Relate tab.

4. In the list of existing terms, click Relate on the right-hand side of a term to add it
to the current glossary.

Notes:

* You can use the search field at the top of the page to filter the list of existing
terms.

* You can click Unrelate on right-hand side of a term, on any of the tabs, to
remove the term from the current glossary.

See Also

o Creatinga Term
o Associating a Term with a Glossary

o Related Terms subpage
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Creating a Glossary

Creating a Glossary

To create a glossary:
1. Select Glossaries.
2. Click the New Glossary button on the upper-right corner.
3. Inthe New Glossary dialog box that opens:
1. Enter a Name to identify your new glossary.

2. Optionally, if you want your new glossary to be a child of an existing
glossary:

1. Write in Parent Glossaries the name of an existing glossary.

Tip: As you write the name of the parent glossary, a context menu appears listing
existing glossaries. You can click an item in the context menu instead of manually writing
the whole name of the parent glossary. You can select multiple parent glossaries.

2. Click Add to set the parent.

Note: Click the # icon to the right-hand side of the parent name to unset the parent

glossary.
3. Define the Status of the glossary using nomenclature you decide upon.
You can use for example the following nomenclature: "Approved", "Not
Yet Approved"”, "Implemented"”, "Not Yet Implemented", and
"Deprecated”.
4. Write a Definition that provides detailed information about the glossary,
such as its purpose and audience.
5. Click Save to save your new glossary.
See Also

o Adding a Child to a Glossary

o Associating a Term with a Glossary

o Deleting a Resource

o New Glossary dialog box
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Glossary Tool Tip

Glossary Tool Tip

Glossary Tool Tips are links to your Team ServerGlossaries of matched words and
phrases in your browser. When you browse any web page that is in your list of
configured sites, matched Terms are automatically highlighted.

The page below is an example of a pop-up definition of the underlined Term.

We cover all types
SNl of sporting events

UPANDRUNNING &5 a proneer n 25 fisld, establshing fsef as the fest integrated Sports Medical Service n the
UAE offerng a network of mulbgisCphnasy prac ity ww. with & we wndmwm, and experence 3l urder one

roof 4 HPW G.OSSUY oehlm’l
SPORTS EVENTS CALENDAR NEWS FEED

Hncea
fa0hy Services ofeced nciode

. s.»mlm-u-z/
o Rebabataton

TN 3-SR0 ¢

« Sports Performance o o 4 pan 002
o Compormie Sarvices __: u.-'. » e o0 wme
* Edecation

& Jom 2002
B B I NRAR A A b I A A 4'3’.‘..‘ PR PR S P }h»f.h.“..la PV

The underlined matches are Terms found in your Team Server installation. When you
hover your mouse over the underlined word, the pop-up box will show the first definition
found in your list of Terms. A link is provided to open your browser to your Team Server
pages of the related Term, where you can browse your company Glossaries for other
related Terms and ER Objects.

After your Glossary Tool Tips are enabled, browsing on any web page that has been
configured to be included will cross reference any matching Terms in your Team Server
installation.

@Note: Glossary Tool Tip is currently only available for Firefox web browser and
requires Greasemonkey Add-on.

@Note: You do not need to be signed in to Team Server to use Glossary Tool Tip,
however if your Team Server installation uses a secure HTTPS connection then the
Team Server's digital certificate must have previously been accepted/imported/installed.

See Also

o Installing Glossary Tool Tips

o Glossaries

o Manage Glossary Tool Tips
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Installing Glossary Tool Tips

Installing Glossary Tool Tips

To enable Glossary Tool Tips on your browser:

1. Install the Firefox browser Greasemonkey Add-on.

2. Open Glossaries from the Navigation Menu and click the button.

Note: The link is also available by clicking Click here for more information at the
bottom of every page, including the initial page, prior to log on.

1. On the page that opens, click the button to install the

Greasemonkey script.

By default, the script has all web pages enabled. Your Administrator can include and
exclude various websites by editing the settings using the administration interface, see
Manage Glossary Tool Tips.

When you browse to an included page that has Terms matched to a Term in your
Glossaries, it will be underlined. Hover over the underlined Term with your mouse to
show the definition or click the popup to open in Connect.

See Also

o Manage Glossary Tool Tips

o Glossary Tool Tip

o Glossaries

o Terms
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Working with Terms

Working with Terms

Terms represent general concepts related to the business, such as "Social Security",
"Tax ID", "Zip Code", or "Call Resolution Time".

When you create a term, you become its owner. You can then associate your term with
ER objects, with glossaries, and with other terms. To see the details of an existing term,
find it and open its term page.

Topics

o Creatinga Term

o Loading Terms from a CSV File

o Searchingfora Term

o Editinga Term

o Associating a Term with a Glossary

o Associating a Term with Another Term
o Associating a Term with an ER Object

o Linked Terms

o Matching a Term with ER Objects

o Discussing Terms

o Following Terms

o Editing the Stewards of a Term

o Adding an Attachment Attribute to Terms

o Deletinga Term

See Also

o Terms Search Page

o Term Pages
o Term API

o Working with Glossaries
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Associating a Term with a Glossary

Associating a Term with a Glossary

To associate a term with an existing glossary:

1. Open the page of the target term. You can search for it.

2. Open the BRelated Glossaries subpage.

3. Open the Relate tab.

4. In the list of existing glossaries, click Relate on the right-hand side of a glossary
to associate it with the current term.

Notes:

* You can use the search field at the top of the page to filter the list of existing
glossaries.

* You can click Unrelate on right-hand side of a glossary, on any of the tabs, to
disassociate the glossary with the current term.

See Also

o Creating a Glossary
o Adding a Term to a Glossary

o Related Glossaries subpage
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Associating a Term with an ER Object

Associating a Term with an ER Object

To associate an existing term with ER objects:

1. Open the page of the target term. You can search for it.

2. Open the “#Related ER Objects subpage.

3. Open the Relate tab. The tab contains a search page, similar to the ER Objects
page.

4. Inthe list of ER objects, click Relate on the right-hand side of an ER object to
associate it with the current term.

Notes:

* You can use the search field at the top of the page to filter the list of existing ER
objects.

* You can click Unrelate on the right-hand side of an ER object to break its relation
with the current term.

See Also

o Associating an ER Object with a Term
o Related ER Objects subpage
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Associating a Term with Another Term

Associating a Term with Another
Term

To associate an existing term with another existing term:

1. Open the page of one of the terms. You can search for it.

2. Open the ElRelated Terms subpage.

3. Open the Relate tab.

4. Inthe list of terms, click Relate on the right-hand side of a term to associate it
with the current term.

* You can use the search field at the top of the page to filter the list of existing
terms.

* You can click Unrelate on the right-hand side of a term to break its relation with
the current term.

* As well as with relating terms, you may also group terms by Term Entity Type.
See the Creating a Term page on how to do this.

See Also

o Creatinga T Term

o Related Terms subpage

Embarcadero Technologies 125


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Working_with_Terms
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Term_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Searching_for_a_Resource_of_a_Specific_Resource_Type
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Related_Terms
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Creating_a_Term
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Creating_a_Term
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Related_Terms

Creating a Term

Creating a Term

To create a term:

1. Select Terms.
2. Click the New Term button on the upper-right corner.
3. On the New Term dialog box that opens:

1. Enter the Name of your new Term.

2. Define the Status of the Term using a nomenclature you decide upon.
You can use for example the following nomenclature: "Approved", "Not
Yet Approved", "Implemented”, "Not Yet Implemented", or
"Deprecated".

3. You are also able to choose a Term Entity Type. You can also choose
your own nomenclature. For example, Entity Term Type could provide a
way to distinguish between different types of Terms. This makes it easier
for you to see the relationship and understand the distinction. It also
allows for Terms with the same name but different type. Examples of
types might include the Subject Area, Documents, Reports or Domains.

4. Optionally, if you want to add your new Term to existing glossaries, for
each one of those glossaries:

1. Write in the Related Glossaries text field the name of the
glossary.

Tip: As you write the name of the glossary, a context menu appears listing existing
glossaries. You can click an item in the context menu instead of manually writing the
whole name of the glossary.

2. Click Add to include the glossaries in the list of related glossaries.

Note: Click the #icon to the right-hand side of a glossary in the list under Related
Glossaries to remove the glossary from the list of related glossaries.

5. Write a Description that provides detailed information about the Term,
such as its purpose and audience.

6. Click Save to save your new Term.

See Also

o Adding a Term to a Glossary

o Associating a Term with Another Term

o Deleting a Resource
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Linked Terms

Linked Terms

Linked Terms allow you to implement Terms in your Glossaries much faster and make
use of taxonomies already in use.

A Linked Term is a term associated to an ER Object, taking the name and description
from it. Linked Terms are automatically created when a Domain, Model or Submodel ER
Object is synchronized. Their properties are populated from the ER Object.

It is possible to create Linked Terms by clicking the option in the header of the ER
Object.

@Note: Linked Terms can be exported but cannot be imported since they only exist
when linked to an object.

Enable Linked Terms Creation

To enable Linked Terms to be automatically created you need to modify a property
value in the configuration file located at <installation
dir>\tomcat\webapps\ROOT\WEB-INF\config.properties .

The property is linkedtermsetl.enabled=false. Change the value to true to enable the
creation of Linked Terms. It is necessary to restart Tomcat after changing the property.
Enable Linked Terms Creation on Repositorty
Standalone Upgrade Scenario

To enable Linked Terms when upgrading from an environment having only Repository
installed, an extra step needs to be performed.

First enable the Linked Term creation with the procedure above and then execute the
following query against the database before performing the data migration.

Update SYNC PROPERTY set VALUE = (select min(Object History ID) from
Object History) where NAME= 'Object History LastId';

See Also

o Creatinga T Term

o Related Terms subpage
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Matching a Term with ER Objects

Matching a Term with ER Objects

Team Server lets you associate any term with ER objects that contain the target term.

To match an existing term with ER objects:

1. Open the page of the target term. You can search for it.

2. Open the %#Related ER Objects subpage.

3. Open the Found In tab. The tab contains a search page, similar to the ER
Objects page.

4. Click Refresh.

Team Server finds any ER object that contains the current term in its name or
description, and adds it to the Found In tab. You can also see matched ER objects in the
View tab, listed after related ER objects.

In the Found In tab, you can click the Unmatch button. This will remove the matching of
the ER object and it will no longer be listed under the View tab. The Re-Match button
will match ER objects that you manually unmatched.

Clearing the Auto Match tick box will disable the Auto Match function and any items
that you Unmatch will be saved.

See Also

o Matching an ER Object with Terms

o Related ER Objects subpage
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Working with ER Objects

Working with ER Objects

ER objects are objects from ER/Studio Repository that you can access from Team
Server.

To see the details of an ER object, find it and open its ER object page. To find an ER
object, you can:

o Browse your ER objects using the Model Explorer page.

o Use the simple search.

Topics

o Browsing ER Objects

o Searching for an ER Object

o Associating an ER Object with a Term

o Matching an ER Object with Terms

o Discussing ER Objects

o Following ER Objects

o Adding an Attachment Attribute to ER Objects
o Configuring Sensitive Data Alerts

See Also

o ER Objects Search Page

o ERObject Pages

o Linked Terms
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Associating an ER Object with a Term

Associating an ER Object with a Term

To associate an ER object with an existing term:

1. Open the page of the target ER object. You can search for it.

2. Open the ElRelated Terms subpage.

3. Open the Relate tab. The tab contains a search page, similar to the Terms page.

4. Inthe list of terms, click Relate on the right-hand side of a term to associate it
with the current ER object.

* You can use the search field at the top of the page to filter the list of existing
terms.

* You can click Unrelate on the right-hand side of a term to break its relation with
the current ER object.

See Also
o Linked Terms

o Associating a Term with an ER Object

o Related Terms subpage
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Browsing ER Objects

Browsing ER Objects

You can browse the hierarchy of ER objects from the Model Explorer page.

In this hierarchy, you can expand every ER object too see its content, and you can click
any ER object to access its description page, which contains links that you can use to
continue browsing your ER objects.

Model Explorer
~ BN localhost
"@ Projects

- j] All_objects_diagram_adding_BDOs.dml

» @ All_objects_diagram_adding_BDOs_DD
= @8 Data Lineage
b # Orders @
= Enterprise Dictionaries
4 @ Workspaces

As you hover over certain ER objects, such as diagrams, Team Server displays pop-up
windows with detailed information about the ER object. Hovering over the name of an

ER object with an eye icon, such as a model or a submodel, displays a miniature picture
of the ER object.

~ B Data Lineage
» M Address Extract to Staging @

b Y Geography Transformation / Load
» @ Modeil.DM1L
¥ €8 MNorthwind.dmil
4 ﬁ Enterprise Dicticnaries
4 @ Workspaces

i Geography Transformation / Load
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Configuring Sensitive Data Alerts

Configuring Sensitive Data Alerts

7.\ ContactCreditCard

OFE

¥
4 Not linked to any term

*Confidential Information® Protected under the DPA

@( ustomer information

Header of an ER object that matches two alert conditions.

You can configure security properties and attachments so that Team Server displays
custom alerts on the header of the pages of ER objects bound to those security
properties and attachments, or that have a specific value for those.

This feature lets you warn about sensitive data. For example, you can show a message
on any ER object bound to a certain security property with a value of "High", and
describe in the alert the risks of not keeping the ER object information confidential.

To configure these sensitive data alerts, you must define alert conditions using the
Alerts subpage of the target security property or attachment.

Topics

o Adding a Sensitive Data Alert Condition
o Editing a Sensitive Data Alert Condition

o Deleting a Sensitive Data Alert Condition

See Also

o Condition Alerts

o Object Alerts Tab
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Adding a Sensitive Data Alert Condition

Adding a Sensitive Data Alert
Condition

To add a sensitive data alert condition to a security property or attachment:

1. Open the page of the target ER object. You can search for it.

2. Open the Alerts subpage.
3. Click Add New Condition to add a new alert condition resource to the page.
4. On the new alert condition resource:
1. On the Show Alert for Matching field, select one of the following values:

* Bound Object if you want the alert condition to affect any ER
object bound to the current security property or attachment.

* Value if you want the alert condition to affect any ER object
bound to the current security property or attachment with a
specific value. Enter the target value into the input field on the
right-hand side.

2. Select an Alert Level, either Notice or Info. The alert level determines
the icon that Team Server shows along with the Notification Text.

3. Enter into Notification Text the text of the notification.

4. From the Notification Text field, press S to take the focus out of
the field. Team Server saves field values as you take the focus out of
them.

Your alert condition is now in effect. You can edit it later or delete it.

See Also

o Editing a Sensitive Data Alert Condition

o Deleting a Sensitive Data Alert Condition

o Condition Alerts
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Deleting a Sensitive Data Alert Condition

Deleting a Sensitive Data Alert
Condition

There are two methods of deleting an existing sensitive data alert condition:
Option 1:

1. Open the page of the security property or attachment that contains the alert
condition. You can search for it.

2. Open the Alerts subpage.

3. Click Delete Condition on the target alert condition resource.
Option 2:
1. Go to My Settings > Admin > Object Alerts (super users).
2. On the right of the condition you want to delete, click the blue Delete button.
3. Click OK on the deletion warning popup.

While super users can delete any alert condition, authenticated users can only delete the
alert conditions that they create.

See Also

o Adding a Sensitive Data Alert Condition

o Editing a Sensitive Data Alert Condition
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Editing a Sensitive Data Alert Condition

Editing a Sensitive Data Alert
Condition

To edit an existing sensitive data alert condition:

1. Open the page of the security property or attachment that contains the alert
condition. You can search for it.

2. Open the Alerts subpage.
3. Locate and modify the target alert condition resource.

Team Server saves text input field values as you take the focus out of them. After you
change a text value, press S or change another option so that Team Server saves
your changes.

Alternatively, if you are a super user, you can edit any existing alert condition from the
Obiject Alerts Tab of your Admin menu.

See Also

o Adding a Sensitive Data Alert Condition
o Deleting a Sensitive Data Alert Condition
o Object Alerts Tab
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Matching an ER Object with Terms

Matching an ER Object with Terms

Team Server lets you associate any ER object with terms that contain the target ER
object.

To match an existing ER object with terms:

1. Open the page of the target ER object. You can search for it.

2. Open the ElRelated Terms subpage.

3. Open the Match tab. The tab contains a search page, similar to the Terms page.
4. Click Refresh.

Team Server finds any term that is present in the name or the description of the current
ER object, and adds it to the Match tab. You can also see matched terms in the View
tab, listed after related terms.

In the Match tab, on the right-hand side of the term entries, you can click Unmatch to
unmatch matched terms, or click Re-Match to match terms that you manually
unmatched.

See Also

o Matching a Term with ER Objects

o Related Terms subpage
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Online Help for Team Server 2016

Online Help for Team Server 2016

Getting Started

o % What's New

o Release Notes

o Installation Notes | Database Server Requirements

o Install and Configure Team Server and Repository

o Upgrading Team Server and Repository

o Tutorials

Administrator Guide

o Starting Team Server

o Data Synchronization

o Security
o Scheduling

o Maintenance

o Configuration
* Admin Page

» Manage Search Results

» Changing the Interface of Team Server

* Manage Glossary Tool Tips

*  Optimizing System Performance

o Architecture

o Tools

Reference

o Evaluation Resources

o Troubleshooting

o Glossary
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Online Help for Team Server 2016

User Guide

o Connecting to Team Server

o Working with Resources:

=  Glossaries

= Terms
» People

*» ER Objects

» Data Sources

= | ogin Credentials

o Using Reports

o User Interface

Developer Guide

o Obtaining Authorization to Use the API
o Browsing Resources
o Managing Resources

o Enabling Secure APl Requests

o APl Reference

ER/Studio Team Server Core

Enterprise model and metadata collaboration
for context, consistency, and compliance
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Working with Data Sources

Working with Data Sources

Data sources are sets of data that define how to establish a connection to a specific
database.

Topics

o Creating a Data Source

o Data Source Fields for a Specific Database Management System

o Searching for a Data Source

o Editing a Data Source

o Associating an ER Model with a Data Source

o Associating a Data Source with a Login Credential

o Discussing Data Sources

o Following Data Sources

o Editing the Stewards of a Data Source
o Adding an Attachment Attribute to Data Sources
o Deleting a Data Source

See Also

o Data Sources search page

o Data Source Pages

o Login Credentials
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Associating a Data Source with an ER Model

Associating a Data Source with an ER
Model

To associate a Data Source with an ER Model:

1. Open the ER Objects page from the Navigation bar. In the left Navigation Bar,
filter by Models.

2. Click on the Model that you would like to associate with the Data Source.

3. Open the * Related Data Sources subpage.

4. Open the Relate tab. The tab contains a search page, similar to the ER Objects
page.

5. In the list of Data Sources, click Relate on the right side of a Data Source to
associate it with the current ER Model.

Notes:

* You can use the search field at the top of the subpage to filter the list of existing
Data Sources.

* You can click Unrelate on the right side of a Data Source to break its relation
with the current ER Model.

See Also

o Creating a Data Source

o Data Sources search page
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Associating a Data Source with a Login Credential

Associating a Data Source with a
Login Credential

The Related Data Sources subpage of Login Credentials lists the Data Sources that are
either related to the current Login Credential, or that can be related to the Login
Credential.

You can use the Related Data Sources page to relate or unrelate Data Sources to the
current Login Credential.

The page is divided in two tabs:

View Tab

The View Tab displays a list of related Data Sources. The list shows the Data Sources
currently related to the selected Login Credential.

Descrigion : - LC1
Related Data Sources . S

Permaisions

Relate Tab

The Relate Tab allows you to relate and unrelate Data Sources to the current Login
Credential.

The Relate tab contains a list of Data Sources that can be related to the Login
Credential. The list is arranged with alphabetical navigation and contains a search box.

On the right side of the Data Sources entries, you can click Relate to relate a Data
Source to the current Login Credential, or you can click Unrelate to unrelate the target
Data Sources from the current Login Credential.
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Associating a Data Source with a Login Credential
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See Also

o Data Source Pages
o Login Credential Pages
o Working with Login Credentials
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Creating a Data Source

Creating a Data Source

To create a data source:

1. Select Data Sources.

2. Click the New Data Source button on the upper-right corner.

3. On the New Data Source dialog box that opens:

1.

7.

Enter a Name for your new data source. Names of data sources in Team
Server must be unique.

Write a Definition that provides detailed information about the data
source, such as its purpose and audience. You can also optionally enter a
Production Level, Location, and Status as per your convenience.

Select from the Type combo box the database management system
(DBMS) that stores the database.

Fill the fields after the Type field and before the Custom Properties field.
These fields change depending on the selected DBMS Type. See Data

Source Fields for a Specific Database Management System.

Optionally, under Custom Properties, you can define custom properties
for the data source. For each property:

1. Enter the Name of the property.
2. Enter the Value for the property.

3. Click Add to add the defined property-value pair to the list of
properties of the data source.

Under Login Credentials, you can define the login credential to connect
the data source. If you prefer, you can do this step later.

1. Select one option:

» User/Password: Define User Name and Password for the
login credential. You can edit it later to modify or include
more information.

= OS Authentication: Enter Trusted Host and Role.

» Use existent Login Credenditals. Allow you to choose
one that already exists.

* No login information. Allows you to create or relate the
login credential later.

Click Save to save your new data source.
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Data Source Fields for a Specific Database Management System

@Note: Adding data sources in Team Server makes them available into ER/Studio
Data Architect for the purposes of connecting or mapping.

See Also

o Deleting a Resource

o New Data Source dialog box

Data Source Fields for a Specific
Database Management System

The following tables provide details about the data source fields that are specific to a
database management system: DB2 LUW, DB2 z/OS, InterBase, Firebird, JDBC, MySQl,
ODBC, Oracle, SQL Azure, SQL Server, Sybase, Sybase |1Q.

You can access these fields when you create a data source or when you access the
description page of an existing data source.
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Data Source Fields for a Specific Database Management System

DB2 LUW

Item

Description

Use DB2 client
aliases

Check Enable to allow using DB2 client aliases.

Host Name

IP address or host name of the database server.

Port

Network port where the database server is listening.

Remote DB Name

Name of the target database.

Schema ID

Identifier of the target schema.

Functional Path

The functional path.

OS Authentication

Check Enable to log in to the database with the credentials of a user of the
operating system where DB2 LUW is running.

DB2 z/OS

Item

Description

Use DB2 client
aliases

Check Enable to allow using DB2 client aliases.

Host Name

I[P address or host name of the database server.

Port

Network port where the database server is listening.

Remote DB Name

Name of the target database.

Schema ID

Identifier of the target schema.

Functional Path

The functional path.

OS Authentication

Check Enable to log in to the database with the credentials of a user of the
operating system where DB2 z/OS is running.

InterBase
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Data Source Fields for a Specific Database Management System

[tem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Character Set Character set of the database.
Dialect Dialect of the database.
Role Role to access the database.
Database file path |Path to the database file.

Firebird

Item Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Character Set Character set of the database.
Dialect Dialect of the database.
Role Role to access the database.
Database file path |Path to the database file.

JDBC

I[tem Description ‘

Connection URL |URL to connect to the database.
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MySQL

[tem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Default Database Name of the target database.
Windows Check Enable to use native Windows authentication to connect to the
Authentication target database.

ODBC

[tem Description

Use DSN Check Enable to use DSN to connect to the target database.

Connection String |String that defined how to connect to the target database.

Oracle

There are four different ways you can connect to an Oracle database. Use the Use
combo box to select the system you want to use: Alias, Connect Descriptor, SID, Service
Name.
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Connecting to Oracle with Alias

Item

TNSNames.ora Alias
Instance Name
Role

Windows
Authentication

Description
Alias to connect to the database.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the
target database.

Connecting to Oracle with Connect Descriptor

Item

Connect Descriptor
Instance Name
Role

Windows
Authentication

Description
Description of the connection to the database.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the
target database.

Connecting to Oracle with SID

I[tem
Host Name
SID
Port

Instance Name

Role

Windows
Authentication

Description
IP address or host name of the database server.
Oracle system identifier that uniquely identifies the target database.
Network port where the database server is listening.
Name of the database instance.
Role to connect to the database.

Check Enable to use native Windows authentication to connect to the
target database.

Connecting to Oracle with Service Name
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Data Source Fields for a Specific Database Management System

Item

Description

Host Name

IP address or host name of the database server.

Service Name

Service name that identifies the target database.

Port

Network port where the database server is listening.

Instance Name

Name of the database instance.

Role

Role to connect to the database.

Windows
Authentication

Check Enable to use native Windows authentication to connect to the
target database.

SQL Azure

Item

Description

Host Name

IP address or host name of the database server.

Default Database [Name of the target database.

SQL Server

Iltem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Protocol Protocol to use for the network connection. You can choose any of the
following options:
o TCP/IP (default). Standard network protocol.
o Name Pipes. Windows-specific network protocol.
Encryption Check Enable to encrypt the network communication.
Default Database Name of the target database.
Packet Size Size of the network packets.
Windows Check Enable to use native Windows authentication to connect to the
Authentication target database.

Sybase
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Data Source Fields for a Specific Database Management System

Item

Description

Use Sybase SQL.INI

Check Enable to use Sybase SQL.INI aliases.

aliases

Host Name IP address or host name of the database server.

Port Network port where the database server is listening.
Encryption Check Enable to encrypt the network communication.

Default Database

Name of the target database.

Packet Size

Size of the network packets.

Max Connections

Maximum number of connections that can be established.

Character Set

Character set of the database.

Kerberos
Authentication

Check Enable to use the Kerberos network authentication protocol to

connect to the target database.

Sybase 1Q

Iltem Description
Host Name IP address or host name of the database server.
Port Network port where the database server is listening.
Database Name of the target database.
Windows Check Enable to use native Windows authentication to connect to the
Authentication target database.

See Also

o Creating a Data Source

o Data Source Description page
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Working with Login Credentials

Working with Login Credentials

Login Credentials are security containers that store and manage passwords for
accessible Data Sources from Team Server. Login Credentials contain an alias that
identifies the credential for sharing.

Only users with Update/Delete permission on Data Sources are able to edit Login
Credentials. Any password changes are invisible to common users.

To see the details of a Login Credentials, browse to it and open the corresponding
Login Credential page.

Topics

o Creating Login Credentials

o Editing Login Credentials

o Deleting Login Credentials

o Browsing Login Credentials

o Associating a Login Credential with a Data Source
o Auditing the Usage of Login Credentials by other Product

See Also

o Login Credential Pages

o Login Credentials Search Page

o Data Sources
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Creating Login Credentials

Creating Login Credentials

You can create a Data Source Login Credential at the same moment you are creating
the data source or you can do it later.

To create a Login Credentials:

1. Select the Data Sources search page and then select Related Login Credentials
on the left-hand sidebar.

2. Click the New Login Credentials button on the upper-right corner.
3. On the New Login Credentials dialog box that opens:

1. Define the Name of your new Login Credential.

2. Choose the type of authentication you prefer:

* Type the User Name. User Name is a login name for a Data
Source. Then enter and confirm the Password. The password that
allows access to the Data Source. For platforms that may not
require a password such as Sybase, this field may be left empty.

» Select OS Authentication. This option disables Name, Password
and Confirm Password fields since the information will be read
from the current OS login. The Trusted Host field appears.

@Note: Include the name of the host in Trusted Host in case your server requires it. If
you do not include it when necesary, Team Server will show the exception that your
database server provides.

3. Define a Role for the Login Credential.

4. Write a Definition that provides detailed information about the Login
Credential, such as its purpose and users group.

5. Click Save to save your new Login Credential.

See Also

o Associating a Login Credential with a Data Source

o Deleting Login Credential

o Login Credentials Search page
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Editing a Resource

Editing a Resource

To edit a resource:

1. Open the page of the target resource. You can search for it.

2. Open the == Description subpage.

3. Click Edit to enter the edit mode. In edit mode, the Description page provides
fields to define the values of each property of the target resource.

4. Modify the resource properties.

Tip: For information about the fields that you can edit, check the documentation of the
description page of the type of resource that you are editing.

5. To save your changes, click Save at the end of the page.

@Note: To automatically update any matched items to the edited changes, the Auto
Match tick box on the Found In tab must be enabled.

See Also

o Editing the Stewards of a Resource
o Working with Glossaries

o Working with Terms

o Working with Data Sources
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Deleting Login Credentials

Deleting Login Credentials

You can delete a Login Credential if you have proper permissions or if you are a super
user.

To delete a Login Credentials from Team Server:

1. Open the page of the target Login Credential. You can search for it.

2. On the Login Credential page, click [Delete] on the header.

3. On the confirmation dialog box that opens, click OK.
The target Login Credential is not available anymore in Team Server.

Note: Deleting a Login Credential does not delete the Data Source associated with it.

See Also

o Creating Login Credentials

o Related Login Credentials
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Browsing Login Credentials

Browsing Login Credentials

To search for Login Credentials:

1. Select the Data Sources search page and then select Login Credentials on the
left-hand sidebar.

2. Enter your search Login Credentials in the search field.

As soon as you stop typing, Team Server filters the list of Login Credentials and displays
only the ones that meet your search criteria. Click their name to open their resource

page.

See Also

o Search Pages
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Login Credential Pages

Login Credential Pages

Login Credential pages provide information about the Description and the Related Data
Sources.

To open a Login Credential page, follow a Login Credential link. If you are looking for a
specific Login Credential, you can use the Login Credentials Search page .

Login Credentials pages share a common header, as well as a common sidebar. When
you click the items in the sidebar, you get access to information pages about different
aspects of the target Login Credential.

Login Credentials Pages Header

Sales Representative

Lagin Credentials

The Login Credential header shows:
o The Login Credential icon.
o The name of the Login Credential.
o The type of resource ("Login Credentials").

o If you have proper permissions or if you are a super user, you can click [Delete]
to delete the Login Credential.

Login Credentials Pages Sidebar

Login Credentials pages provide a sidebar with the following items:

Embarcadero Technologies 156


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Browsing_Login_Credentials
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Overview_of_User_Roles#Super_User
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Deleting_Login_Credentials

Login Credential Pages

Item

Description

Description

Provides detailed information about the Login Credential.

—
—

Related Data
Sources

Shows a list of data sources that are associated with the current Login
Credential.

Permissions

Opens the users and groups permissions tab for the login credential.

See Also

o Working with Login Credentials
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Working with Groups

Working with Groups

Groups are designed as a shortcut to get in touch with other elements. It also allows you
to have related elements concentrated in one place.

When you create a group, you become its owner. To see the details of an existing
group, find it and open its group page. You can then includedata sources.

Topics

o Creating a Group

o Searching for a Group

o Editing a Group

o Including a Member into a Group

o Discussing Groups

o Following Groups

o Editing the Stewards of a Group
o Deleting a Group
o Manage Permissions for a Group

See Also

o Group Pages

o Working with Resources
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Creating a Group

Creating a Group

To create a group:
1. Select Data Sources.
2. Click the New Group button on the upper-right corner.
3. Inthe New Group dialog box that opens:
1. Enter a Name to identify your new group.
2. Optionally, if you want your new group to be a child of an existing group:
1. Write in Parent Group the name of an existing group.

Tip: As you write the name of the parent group, a context menu appears listing existing
groups. You can click an item in the context menu instead of manually writing the whole
name of the parent group.

2. Click the group name to set the parent.

Note: Click the # icon to the right-hand side of the parent name to unset the parent

group.
3. Define the Status of the group using nomenclature you decide upon. You
can use for example the following nomenclature: "Approved"”, "Not Yet
Approved", "Implemented”, "Not Yet Implemented", and
"Deprecated”.
4. Write a Definition that provides detailed information about the group,
such as its purpose and audience.
5. Click Save to save your new group.
See Also

o Deleting a Group

o New Group Dialog Box
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Members

Members

(o

The Members subpage of group pages lists the data sources included into the group.

If you are a steward of the group, you can also use this page to include or exclude data
sources to the group.

The page is divided in two tabs:
o The View tab displays a list with the data sources included into the group.

o The Include tab lets you include and exclude data sources.

(e

(0 Ao A E

Include Tab

The content of the Include tab is similar to the content of the Data Sources page. For
example, it has a search box, and letters to navigate the matching data sources.

On the right-hand side of the data sources entries, you can click Include to include a
data source into a group, or you can click Exclude to exclude the target data source
from the current group.

On the top of the list of data sources, you can click Include All to include all the listed
data sources to the current group, or you can click Exclude All to exclude all the listed
data sources from the current group.

See Also

o Working with Data Sources

o Working with Groups
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Troubleshooting

Troubleshooting

Here you can find a list of some frequently encountered problems and their solutions or
workarounds.

Most problems can be fixed by making sure that your system is running the latest
software. Before you start troubleshooting, it is advised that you make sure your product
is up to date.

Cannot Connect to Team Server

Unable to Connect
If your web browser cannot establish a connection to the Team Server server:
o Check that the URL you are trying to access is Team Server's.
o Check that your system has a working connection to the Team Server server.

o Check that Team Server is running. See Starting Team Server.

o Tryincreasing the maximum memory assigned to Team Server. See Changing
the Memory Limit of Team Server.

Template Could Not be Loaded

"Template could not be loaded..."

If you get this error message, you might need to restart the Team Server server. Contact
your super user.

Team Server is not showing the Start Here page

Start Here page may be not shown the first time you access the home page using https
connection. To solve this and obtain the certificate open http://www.embarcadero.com
on the same browser and then refresh the Team Server home page.
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Troubleshooting

@mbarcadero Q,
My Settings = | Log Qut

Home Glossaries  Terms  People ERObjects  ERTook  DutaSowrces  Monitor  Apps

Stream

Description
W Community

'B Documentation

Q [ Gements Mevwork Scurces Timeline Profles Rescurces Audits | Conscle |

-

Loading Pages Takes Too Much Time

Try increasing the maximum memory assigned to Team Server. See Changing the
Memory Limit of Team Server.

Log Error Messages

There are some log files in the Team Server installation folder that you can watch for
error messages and warnings. Here you can see some errors that you might see
registered in those log files, what the errors mean, and how to solve them.

tomcat\logs\<domain>.<date>.log

java.lang.OutOfMemoryError: Java heap space

You need to increase the maximum memory assigned to Team Server. See Changing
the Memory Limit of Team Server.
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Troubleshooting

etlvar\log\log_<timestamp>\*.log

<date> - SyncDiagram.bat (stdout) - Could not reserve enough space for
object heap

The application cannot start because there is not enough contiguous memory in the
system that can be allocated for the application. For example, you are using a virtual
machine and have more memory allocated to Team Server than is available on the
virtual machine.

You need to decrease the maximum memory assigned to Team Server. See Changing
the Memory Limit of Team Server.

tomcat\logs\embarcaderoteamserver-stdout.log &
tomcat\logs\embarcaderoteamserver-stderr.log

The creation of these logs is turned off by default. You may want to enable it for
debugging purpose.

From Windows: Start > All Programs > Team Server 2016 > Configure Tomcat
Service.

On the Logging tab set Redirect Stdout and Redirect Stderror values to "auto"
(without quotes) and restart the service.

" s EmbarcaderoTeamServer Properties x|

General I Log On Leogging IJa'u'a I Smrmpl Shutdown |

Level: II,-,fc, j

Log path:
I C:\Embarcadero\Embarcadero Team Server 20168tomcatlogs |

Log prefix: I commons-daemon

Pid file: I

Redirect Stdout:

| .|

Redirect Stderror:

| =]

Ok I Cancel

Apply |

Embarcadero Technologies 163


http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Changing_the_Memory_Limit_of_Team_Server
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Changing_the_Memory_Limit_of_Team_Server
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Tomcat_Configuration_Application
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Tomcat_Configuration_Application
http://docwiki.embarcadero.com/TeamServer/ERStudio/2016/en/Restarting_ER/Studio_Team_Server

Troubleshooting

Synchronization Issues

Synchronization fails if Tomcat Service Runs by Domain Administrator
(16.0.0)

See ERStudiolLauncher.log:

An error was detected after process was created. ERROR CODE: 1314, ERROR MSG: A
required privilege is not held by the client.

If the Synch process is not working because of this error, please follow next steps:

1. Go to the Windows Services Panel and right-click on EmbacaderoTeamServer
service, then click on Properties.

2. Go to Log On tab and check This Account. Introduce the domain account you
want to use.

@Note: The account needs to have “Log in as Service” privileges in the Local
Security Policy. This is actually assigned automatically if you enter in the credentials in
the Windows Services Panel.

) Services (Local)

EmbarcaderoTeamServer _Neme = | Description | Status | Startup Type | lLlogonas |
& Application Experience Processes ... Manwal Local System
Sart the service €2 Application Identity Determines... Manwsal Local Service
S Application Tnformation FaciRates ... Marwal Local System
Description: ,’_ Application Layer Gateway Service Provides s... Manwal Local Service
Apache Tomcat 7.0.54 Server - & Application Management: Processesi... Started  Manwal Local System

tRtp:/Romeat.apache.orgf —.(;"; RGPS D T R IR EmbarcaderoTeamServer Properties (Local Computer) B3

£l Base Fitering Engine
‘,’,;’:cassand'a General LogOn ]Hecwety| Dependencies |
-G Certficate Propagation

G CNG Key Tsolation 09 o0

£, COM+ Event System " Local System account

{6, COM4 System Application I= | Al service to interactith deskton

& Computer Browser

r: Cre:riial Msnager @ [This account] Iccm_lool@clrbofcadclo.com Browse... |
S, Cryprographic Services 5 =} T

‘£, DCOM Server Process Launcher = |

-E.;";Deshtop Authority Client Provisionir Corfm ne :

S Deskrop Window Manager Session

G, DHCP Chent Help me configue user account kg on oplions.

&), Diagnostic Policy Service

&) Diagnostic Service Host:

‘) Diagnostic System Host

£, Disk Defragmenter

,’.( Distributed Link Tracking Clent

S Distributed Transaction Coordinato
G DNS Client

Sl Embarcadero Repository Communic
»CQ; Embarcadero Repository Database
»:’_.{'; Embarcadero Repository Event anc
) EmbarcaderoTeamServer

E)Encrypting File System (EFS) [ok | comcel

1€} Extensible Authentication Pratocol

&), Function Discovery Provider Host The FOPH...,  Started Manual Local Service
S Function Discovery Resource Publication Publiches t... Marwal Local Service
Sk Group Policy Clent The servic...  Started Automatic Local System
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3. Now you have to modify the RepoDiagrams.bat file under <installdir>\portallntf
directory, so that it always runs Portallntf.exe directly instead of using
ERStudiolLauncher. The contents of the batch file could be like:

@echo off
set SELECTED DIAGRAM=%1
Start /wait /min "erstudio" portalintf.exe -m "ProcessDiagramObjects.bas"

Oracle

The default number of processes that can be set in Oracle XE is 40. If you exceed the
amount of processes you may get a failure, identified in the synchronization logs as
ORA-12519, TNS:no appropriate service handler found. The synchronization logs are
available in the directory.

SQL*Plus: Release 18.2.8.1.8 — Production on Wed Jan 15 11:81:37 26814
Copyright <c> 1982, 2885, Oracle. All rights reserved.

SQL» connect sys-1234 as sysdba
Connected.
SQL» alter system set processes=150 scope=spfile;

System altered.
SQL>

To fix this error you can increase the number of available processes by doing the
following:

1. Run SQL*Plus and login as SYSTEM. You should know what password you have
used during the installation of Oracle DB XE.

Run the command

“ALTER SYSTEM SET processes=150 scope=spfile;”

g WIN

in the SQL*Plus
6. Restart the database.

If you continue to get this error after increasing the number of available processes by
following the above procedure, you may be using up all available processes and need
to source the reason for this by examining the processes.

Connect to your database either using the sys account or by logging into your Oracle
server and using a direct SQL Plus connection as the Oracle user: sqlplus / as sysdba.
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@Note: If you are still getting errors regarding not available processes, you will have
to manually kill one of the Oracle processes using the kill command. Then use these two
queries to find out how many processes and sessions are currently logged:

1 SELECT COUNT (*) FROM vS$process;
2 SELECT COUNT (*) FROM vS$session;

For Oracle 11g, the default maximum number of processes is 150 (149 available).

Once you have confirmed that you have definitely reached the maximum number of
processes, you can use this query to see what they all are and if they are active:

1 SELECT sess.process, sess.status, sess.username, sess.schemaname,
SQL.sgl text

2 FROM v$session sess, v$sqgl SQL

3 WHERE SQL.sgl id(+) = sess.sqgl id;

Test Data Source Connection Issues

Microsoft SQL Server

If you are trying to connect to one Microsoft SQL Server data sources with ssl enabled
with version 2008 or less, you will get these errors.

Test connection failed

ERROR: Failed to connect.

-- Cause: Failed to create a connection, Please check your settings.

-- Cause: This driver is not configured for integrated authentication.

ClientConnectionld: f33fff4d-228a-4828-bdee-4c18e34f123f | SQL State: 08501, Error
Code: O

-- Cause: Mative Library C:\Embarcadero\Embarcadero Team Server 2016%tomcatishared
Wibhsqljdbc_auth.dll already loaded in another classloader

Accept
Test connection failed
ERROR: Failed to connect.
-= Cause: The connection is closed.
== Cause: The connection is closed. | SQL State: null, Error Code: 0
Accept

Migration issue with HTTPS enabled

There is a known issue regarding the migration process with HTTPS enabled. If you have
HTTPS enabled, the migration process will fail. In order to solve this issue, perform the
following steps:
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1. Configure https using the configurator.
2. End the configuration process without running the migration.

3. Loginto Team Server and access the configurator page through My Settings
menu and then perform the migration process.

See Also

o Overview of the Team Server Tools

o Overview of Data Synchronization
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Glossary

Glossary

Here you can find information about some of the terms that you may run into while you
browser the documentation.

A

Apache Tomcat

Server technology used by Team Server. More information.

B

Breadcrumb trail

A breadcrumb trail is a structured display of resources where the resource to the leftis a
parent of the resource to the right.

1
m

¥ Model1.DM1 > (B Logical > [E§ Main Model
Business Reports

This is one of the folders of shared reports distributed with Team Server. See Solution
Browser, Business Reports.

C

Connection Types

These are the type of connections that people can use to connect to Team Server. Not
to be confused with user types. See Overview of User Connections.

CRUD

Create, Read, Update, Delete usage relationships.

D
Diagram

A graphical presentation of a collection of model elements.
Digital Certificate

A digital certificate (also known as a public key certificate or identity certificate) is an
electronic document that uses a digital signature to bind a public key with identity
information. The certificate can be used to verify that a public key belongs to an
individual. You can view installed certificates in Firefox > Options > Advanced Menu.
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E

ETL

Extraction, Transformation and Load, a process in data warehousing that involves
extracting data from other sources, transforming it to fit business need, and then
loading it into an end target, such as the data warehouse.

L

Logical Model

A logical entity-relationship model conforms to relational theory and contain only fully-
normalized entities. For a logical data model to be normalized, it must include the full
population of attributes to be implemented and those attributes must be defined in
terms of their domains or logical data types.

A logical data model requires a complete schema of identifiers or candidate keys for
unique identification of each occurrence in every entity. The logical model indicates the
current identify selection because there are choices of identifiers for many entities.

P

Pentaho Bl Platform

Architecture and infrastructure to build solutions to business intelligence (Bl) problems.
Team Server builds its reporting features on top of this platform. More information.
Permissions

Gives a user the ability to access the Reporting Repository database. See Overview of
User Roles.

Physical Model

A complete physical data model includes all the database artifacts required to create
relationships between tables and achieve performance goals, such as indexes, constraint
definitions, linking tables, partitioned tables, and clusters.

R

Roles

Team Server provides default roles. These roles are granted permissions to access
actions. The default roles are Authenticated and Super User. See Overview of User
Roles.

Repository

A database where Team Server stores and maintains data. For Team Server, the
database, or repository, is associated with the ER/Studio application.

S

Security
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All users are authenticated before they are able to run queries and reports. Each user
must have a user name and password that is stored in the ER/Studio Repository
database.

Solution

A set of documents defining the processes and activities required to solve a specific
business intelligence problem.
Solution Repository

The Solution Repository is the location where solutions and the metadata they rely on is
stored and maintained. Requests made to the platform to have actions executed rely on
the action being defined in the Solution Repository.

Scheduler

Administrative function to schedule and monitor synchronization of the ER/Studio
Repository with the Reporting Database. See Overview of Scheduling.

T

Technical Reports

This is one of the folders of shared reports distributed with Team Server. See Solution
Browser, Technical Reports.

See Also

o Whatls Team Server

o Overview of the Team Server Architecture
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